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1Introduction

Welcome to ServerStor for Windows, McAfee’s file server backup, restore, and 

data management software application for the NetWare and Windows environ-
ments. Managed from the client workstation, ServerStor offers easy-to-use, 
pull down menus; tool bar icons; full use of the mouse; a variety of data transfer 
options; and a convenient means of finding data that has been stored off-line. 
The network administrator can also run ServerStor from the server console, 
recovering lost volumes after a server failure. 

ServerStor is especially useful for recovering from a system hardware failure or 
for restoring data that has been corrupted or accidentally deleted. And it's a 
fast, safe way of moving large amounts of data from one server to another.

This manual will help you on your way to easier storage management. 

Making It Easy. ServerStor offers clearly presented menu choices and on-
screen messages to guide you through your media operations. 

ServerStor offers an on-line help facility containing information about a wide 
variety of topics related to the operations performed by ServerStor. Refer to 
Appendix A, ”Help” for complete information about on-line help.
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A Powerful Package

This version of ServerStor provides a variety of powerful data management 
features. Here's a list of just a few of them:

� Novell SMS support for NetWare 3.x and 4.x. ServerStor supports the Nov-
ell Storage Management System (SMS), including Target Service Agents 
(TSAs) and the SIDF tape format.

� Support for multiple devices. You can install up to five backup devices 
(daisy-chained) on a single adapter.

� Backup protection for all attached NetWare 3.x and 4.x servers.

� Expanded host adapter and backup device support. ServerStor supports 
many third-party SCSI backup devices. See Chapter 3, “Installing Server-
Stor,” in the manual Getting Started for a list of supported adapters and 
backup devices.

� The Rescue function to recover from server crashes. ServerStor provides 
you with the means to quickly restore a server to its pre-crash state—using 
only one command. You don't even need to reinstall ServerStor or Win-
dows!

� The Protect function. ServerStor allows you to easily add unprotected vol-
umes so that they too can be covered by the Rescue function.

� The Restore Any Day function. If you need to restore a file—or your entire 
system—to the state it was in on a particular date, ServerStor will perform 
the restore in a few simple steps.

� “One-button” backups. You can execute pre-defined backup jobs by using 
the mouse to click the Run Job button.

� Cartridge Rotation. You get your choice of tape rotation schemes. Server-
Stor keeps track of what's on each cartridge, and always prompts you for 
the right cartridge—automatically.
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� Media library support. ServerStor makes it possible to rapidly find off-line 
data, manipulate the transfer of data from one medium to another to the 
Librarian database. In short, with ServerStor you get powerful Librarian 
and media management.

� Wide choice of backup and restore operations. You can choose several dif-
ferent types of backups and restores, ranging from single files and directo-
ries all the way to complete volume contents. You can easily designate 
certain files and directories for inclusion or exclusion. 

� Graphical file system view. It's easy to find and tag files for the various data 
transfer operations you'll want to perform.

� Automatic backups. You can define, save, and schedule backup jobs to 
run automatically in the background.

� Multiple name space support. ServerStor supports DOS, OS/2, Macintosh, 
and other NetWare-supported file and directory names. 

� Data Compression. ServerStor supports backup devices that use hardware 
data compression.

� Job Scheduler. ServerStor includes a Job Scheduler utility that will enable 
you to run unattended backups—on a one-time basis or on a regular 
schedule that is defined by you.
Page 3 ServerStor
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What ServerStor Can Do for You

ServerStor offers reliable solutions to today's most pressing data storage prob-
lems. ServerStor provides an integrated strategy for protecting and managing 
your valuable data, and an easily accessible set of tools to effect that strategy. 

A Librarian for Your Media Cartridges

� ServerStor serves as an on-line card catalog for your media cartridge 
library so that you can organize and track all of your archived and backed 
up data sets.

� You can set up an exclusive group of media cartridges to be used only by 
specified backup jobs. Every time you run one of those jobs, ServerStor 
tells you which media cartridge to load. When a backup job is complete, all 
relevant information about the job is recorded in the Librarian database: 
the job name, the date, the names of the media cartridges used, as well as 
a complete directory of all files backed up during that job.

� Once backup information has been recorded, you can search the Librarian 
database for a file or range of files. The Librarian window depicts exactly 
where the selected file resides in your media cartridge library, the date that 
it was backed up, and the date that it was last modified.

Easy Job Creation and Scheduling

� When you want to create a backup job, the File System window enables 
you to view your on-line file system and quickly tag the files, directories, or 
entire volumes to be backed up. 

� You can run the job immediately, or save it to run later. You can run a 
saved job manually, or automatically using ServerStor's powerful Job 
Scheduler. The Job Scheduler allows you to set up a schedule for all of 
your routine backups, and frees you from attending to them.
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A Complete, Ready-to-Use Data Protection Strategy

� During installation, ServerStor builds a Librarian database to work with 
your installed backup device, and copies pre-defined backup jobs onto 
your system. These jobs comprise McAfee's Restore Any Day data protec-
tion strategy, which you can begin using right away. Restore Any Day also 
serves as the basis for the Rescue function, a disaster recovery feature of 
ServerStor.

� When you routinely back up with Restore Any Day, you can restore any file 
on your system to its state on any given day within the date range you 
specify.

The Rescue Function: Automated Disaster Recovery

� The ServerStor automated disaster recovery procedure is installed on a 
separate disk from the volume on which the ServerStor software resides. 
The Rescue disk is updated each time you perform a Complete or Differen-
tial backup of your system, so it always knows which media cartridges con-
tain the most recent backups. 

� In the event of a catastrophic failure of any Rescue-managed server, you 
can automatically recover with the Rescue function. 
Page 5 ServerStor
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Label Your Backup Media!

ServerStor helps you to easily locate your data by automatically prompting you 
to insert the correct media cartridge when required. It is very important  that 
you be able to identify a requested cartridge. That is, you must affix an external 
label to each media cartridge and mark it with the same ID as appears on the 
cartridge's electronic label (e.g., the label on the tape), if the Librarian database 
is going to be of any value to you. 

To understand this, imagine that you're looking for a magazine article about 
project management. You go to your local library, and after asking the librarian, 
you learn that “Good Project Management” was published in Business Projects 
Monthly, July 1989. The library has every magazine ever published—but each 
and every one is missing its cover. The only way to find that one article is to flip 
through every page of every magazine. This is a library system without external 
labels. 

No user wants to keep mounting tapes (or other media) trying to find one file. In 
the absence of accurate, external labeling, the best library in the business will 
be of little benefit. 
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2Data Protection Strategy

ServerStor's Data Protection Strategy
ServerStor's data protection strategy is built into the product, and works in two 
ways:

� Restore Any Day gives you the ability to restore any file on any ServerStor 
volume to its state on any given day.

� The Rescue function provides automated recovery for all of your Rescue-
managed volumes, in case of a catastrophic server failure.

Restore Any Day

The Restore Any Day strategy provides pre-defined and pre-scheduled backup 
jobs to back up your system:

� A weekly Complete backup of protected volumes

� A daily Differential backup of protected volumes

When you run these jobs, your media cartridge library will contain the data sets 
necessary to restore the entire volume (or any portion of the volume) to its 
state on any given day. Each time a Restore Any Day backup job is run, both 
the Librarian database and the McAfee Rescue disk are updated with catalog 
information about the job: the job name and date, the media cartridge name, 
and the name and date last modified of each file backed up. For details on how 
to Restore Any Day, see Chapter 5, “Restore Operations.”
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The Rescue Function

The Rescue function is a strategy designed to automatically recover any Res-
cue-protected volume from a catastrophic server failure. If such a failure 
occurs, choose the Rescue function button in the tool bar to recover the vol-
ume. 

In the event that the volume where ServerStor or Windows resides is lost, you 
will not be able to choose the Rescue function button. In this case, you can use 
the McAfee Rescue disk to recover the lost volume. See Chapter 5, “Restore 
Operations” for details.
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The Pre-configured Librarian Database

The Librarian database is pre-configured for your environment, based on infor-
mation you supplied at installation time. Your Librarian database is already set 
up to handle the Restore Any Day strategy, and your McAfee Rescue proce-
dure is ready to capture information about your latest backup jobs. This default 
configuration should provide you with a basic data protection strategy for your 
system. 

Example: The ABC Manufacturing Environment

The following example describes how one company uses ServerStor to meet 
its data protection needs in a fictitious NetWare LAN environment. ABC Manu-
facturing makes bicycle parts from recycled scrap metal. ABC has its on-line 
manufacturing system and its accounting system on a NetWare 3.x LAN. 
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The manufacturing system software resides on the file server; records are 
stored on other servers. On the shop floor, several client PCs reside at points 
where assembled parts move along during the manufacturing process. 

Workstation A, just set up to run ServerStor, is used by the network administra-
tor to back up and restore files to file server F. The accounting system resides 
on server G.

Viewing Your Pre-configured Librarian Database

Choose Librarian in the tool bar to display the Librarian window. The Librarian 
window as seen from ABC's Workstation A is shown below:

Librarian Database Structure

The hierarchy depicted in the Librarian window represents the pre-configured 
Librarian database. This database is designed to organize and track each 
backup job you record in the Librarian database, each media cartridge used by 
a job, and each data set stored on a media cartridge. As you record backup 
jobs in the Librarian database, you'll notice this hierarchy expand as each 
object is added in its proper order. Objects in the hierarchy include, in descend-
ing order:

� The Librarian Database Root.

� The media group encompasses the entire pool of media cartridges that can 
be used by your installed backup device type.

� Job groups represent groups of media cartridges that are independently 
managed by ServerStor. Every backup job must be assigned to one and 
only one job group.
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Librarian Database Root

The Librarian database root symbol is shown highlighted in the upper left cor-
ner of ABC's Librarian window. 

Media Group 

Directly below the root in ABC's Librarian window is another symbol that repre-
sents the media group corresponding to ABC's backup device. In your Librar-
ian window, this media group encompasses the entire pool of media cartridges 
that can be used by your installed backup device type. (When you installed 
ServerStor, you selected your backup device type in the server-side Hardware 
Options screen.) ServerStor uses the device information associated with the 
media group to identify the location of your backup device. 

Job Groups

There are pre-configured job groups in your Librarian window in the media 
group: 

� Free Pool

� Restore Any Day

� Archives

The Free Pool Job Group 

ServerStor creates a Free Pool job group under the media group to serve as a 
catch-all pool of media cartridges that you, rather than ServerStor, manage. 
ServerStor regards each media cartridge assigned to the Free Pool job group 
as eligible to be overwritten. Whenever ServerStor needs a free media car-
tridge for a new backup job, it provides you with the list of media cartridges in 
the Free Pool group. You must decide which of these cartridges to use. (Your 
system is pre-configured with one Free Pool job group, which you can see in 
the Librarian window.) If you don't want the data sets on a media cartridge to 
be overwritten, be sure to move it to one of the other job groups.
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" When ServerStor uses a cartridge from the Free Pool group as part of a 
job that uses tapes from another group, ServerStor automatically “moves” 
that tape to the appropriate group.

Restore Any Day Job Group

This job group provides the basis for the Restore Any Day strategy, which 
enables you to restore any file to its state on any day. ServerStor manages all 
of the media cartridges in this group for you; data sets are maintained for a 
default period of one month before they can be overwritten (you can change 
the length of time that data sets are maintained). Two pre-defined jobs are 
assigned to this job group, one for running Complete weekly backups of the 
volume where ServerStor resides, and one for running daily Differential back-
ups.

Archives Job Group

The Archives job group is for cartridges you never plan to overwrite.

You might, for example, use the Archives job group to keep track of your off-
site media cartridges. Another (recommended) usage is to include in this job 
group any data sets on media cartridges imported from other ServerStor instal-
lations. 

Viewing Restore Any Day Pre-defined Jobs

" You won't see the results of a job depicted in the Librarian window until the 
job has actually been run. After the job is run, the save set on the media 
cartridge is given a unique name and recorded in the Librarian database, 
along with date, the names of the media cartridges it used, the data sets 
and files copied.
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1. To view the Restore Any Day pre-defined backup jobs that are sched-
uled to run, access the Run Job dialog box. In the Tools menu, choose 
“Jobs” to display the Run Job dialog box:

2. Choose the Compound option button to display the compound jobs 
available to you. 

A compound job consists of two or more single jobs.

3. Highlight either RAD_CMPL or RAD_DIFF, and click Edit.

" Both the Complete and the Differential jobs are scheduled to run at 
a default day and time. You can change the day and time with the 
Job Scheduler. For more information, see Chapter 8, “Job Sched-
uler.” For detailed information about using Restore Any Day, refer 
to Chapter 4, “Backup Operations.”
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Customizing the Librarian Database

You can customize the Librarian database by defining additional job groups as 
needed. You can, for example, create a new job group to handle data protec-
tion for a particular file system in addition to your regular Restore Any Day 
strategy. This section explains how to define these groups. The two basic steps 
are viewing your installed job groups which define the sets of media cartridges 
you can use to run backup jobs or, if necessary, creating additional job groups.

" If you do not wish to use the installed Restore Any Day strategy, consult 
Chapter 4, “Backup Operations” for alternative backup strategies.

Creating a New Job Group

Create a new job group whenever you need to define an exclusive pool of 
media cartridges to a particular group of related backup jobs. Your system is 
pre-configured with the same Librarian-managed job group that you can see in 
the Librarian window: Restore Any Day. All job groups that you create are man-
aged by ServerStor, based on the media selection method that you assign 
when you create the job group. ServerStor knows when each data set can be 
overwritten, and keeps track of which media cartridge is to be used next. 

1. To create a job group, open the Librarian window and highlight the 
media group. 

2. Choose Create from the Edit menu. The Job Group Properties dialog 
box is displayed.
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3. In the Name text box, type the name of the Job Group. You can assign 
any name you wish, but do not use \ : or +. (You'll hear a beep if you 
type an illegal character.) 

4. In the Job Group Type list box, click the scroll arrow to display avail-
able media selection methods: Linear and Tower of Hanoi; (Linear is 
the default). For this job group, select Linear.

" For a complete explanation of Linear and Tower of Hanoi media 
selection methods, see Chapter 3, “The Librarian and File Sys-
tem.”

5. Under Data Set Expiration, select the button that corresponds to how 
long you want ServerStor to maintain the data sets on all media car-
tridges in this job group. In the example, “six months” was selected.

" ServerStor assigns a cartridge based on the media selection 
method that you specify. There is no need for you to worry about 
which media cartridge to use for a backup; ServerStor does that 
for you. It uses a special algorithm for each media selection 
method, and prompts you for the media cartridge it needs.

6. Choose Add. Note that the new job group has now been added below 
the media group in the Librarian window. You have now configured the 
Librarian database. Your can now create a backup job. 
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Changing to a New Backup Device Type

If you wish to change to a new type of backup device (e.g., a different type of 
SCSI tape drive), you do not need to re-install ServerStor. You can continue 
using the ServerStor Librarian that you used with your original backup device, 
by following this procedure:

1. Install your new SCSI backup device. For details, refer to your hard-
ware manual.

2. Default to the directory in which ServerStor is installed. Type RES-
QINST ↵ to bring up the server-side Main Menu. Choose item 2, Hard-
ware Options.

3. Choose the Check Config button to reconfigure the settings for the new 
backup device. Close the Hardware Options dialog box.

4. Test your new backup device by defining and running a short backup 
job.

" Warning: You will not be able to access your old media cartridges 
if your new backup device type is incompatible with the old.
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Basic Functions of Librarian
" Externally label all your backup media cartridges. If you don't label your 
media cartridges, restoring lost data will be much more difficult, recovering 
from a server crash may not be possible, and the major benefits of having 
ServerStor will be wasted.

The Librarian database helps you perform many different tasks as you manage 
both on-line and off-line storage of data. These tasks can be grouped under the 
following basic functions:

� Tracking files that have been backed up. The Librarian database keeps 
track of the servers, volumes, directories, subdirectories, and files that 
have been backed up. The database also tracks when data was backed up 
and the media cartridge location of your data.

� Organizing backup media. The Librarian database helps you to organize 
your backup media for particular purposes.

� Listing directories and files on a media cartridge. The Librarian database 
tells you what files are on a media cartridge. This is especially useful if you 
do not know what files are on a particular cartridge.
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Structure of the Librarian Database

The Librarian database is structured to keep track of data stored on media car-
tridges. It does this by organizing and tracking various objects. These objects 
include the backup jobs, media cartridges used by the jobs, and the data sets 
stored on the media cartridges. The Librarian database establishes a hierarchy 
that organizes the objects into a logical structure. This is explained in the next 
several sections. (Please refer to the diagram on the next page.)

Data Sets and Media Cartridges

ServerStor refers to a single backup (no matter how small or large—one single 
file or an entire volume) as a data set. The media on which the backup is per-
formed is called the media cartridge. For example, the data set stored on Tape 
1 could be your Monday backup. The data set stored on Tape 2 could be Tues-
day's backup.

Job Groups

Data sets are recorded on media cartridges, and media cartridges are associ-
ated under job groups. You can think of a job group, therefore, as being a 
group of logically related media cartridges. In our example, Tapes 1 and 2 
could be associated with the job group “Weekly Backups.” 
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You may define a job group with special media selection attributes. This will 
help you use job groups to set up (and automate if desired) several types of 
secondary storage strategies.

There are two basic types of job groups:

� Free Pool. ServerStor automatically creates the Free Pool job group at the 
time of installation. You may never delete or insert a Free Pool job group. 
When performing a backup, the Free Pool job group allows the use of any 
cartridge, as long as that cartridge is not currently allocated to any other 
job group in the current library. However, other job groups can “pull” car-
tridges from the Free Pool job group into their own if additional cartridges 
are required. ServerStor looks in the Free Pool job group when it needs a 
new media cartridge. 

Any media cartridge in a Free Pool job group is eligible to be overwritten. 
When you no longer need a media cartridge, you can move it to the Free 
Pool job group. Similarly, if there is a media cartridge in the Free Pool you 
wish to ensure is never overwritten, it may be moved to the Archives 
Group.

The Free Pool job group also contains a chronological listing of its media 
cartridges. This listing scheme places the newest cartridges at the bottom 
of the list and the oldest at the top of the list. This allows you to see a Least 
Recently Used (LRU) list of cartridges in the Free Pool job group.

� Librarian-managed. When you create a Librarian-managed job group, the 
media cartridges assigned to that job group cannot be used by any other 
job group. ServerStor will manage the media cartridges in the Librarian-
managed job group depending upon the media selection method you have 
chosen for the job group. A media selection method will determine which 
media cartridges are selected for a particular backup, how many media 
cartridges to use, and how long to keep the backups.

There are two Librarian-managed job groups created automatically at the 
time of installation:

� Restore Any Day. By default, this job group is targeted by two backup 
jobs which perform Complete and Differential backups. See “McAfee's 
Rescue and Restore Any Day” in Chapter 4, “Backup Operations.”

� Archives. This job group is intended for any backups you wish to keep 
indefinitely.
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When you create your own Librarian-managed job groups, you can choose 
one of two media selection methods. (We'll tell you how to create job 
groups a little later in the section “Creating a Job Group.”)

� Linear.  Every linear job group requires you to specify how long you wish to 
maintain backed up data sets before overwriting them. Any media cartridge 
that you create with a backup job in a linear job group will be kept for the 
period of time (days, weeks, months) that you specify in the Job Group 
Properties dialog box. If you specify “Never,” you will never overwrite any 
media cartridge in this group. (In effect, it becomes another Archives job 
group.)

" The Restore Any Day and Archives created for you during installation are 
linear job groups.

ServerStor tracks the media cartridges for you, prompting you for the proper 
media cartridge to use when performing a backup. You may decide to append 
to a media cartridge or overwrite it when the backup job is created. (This deci-
sion is made in the Backup Options dialog box; see “Backup Options Dialog 
Box” in Chapter 4, “Backup Operations.”) If you elect to append, ServerStor will 
prompt you for the media cartridge that was used for the last backup performed 
in this job group. If the media cartridge is full, you will be prompted for another 
cartridge.

If you decide to overwrite, ServerStor will either use the eligible media already 
mounted in the backup device, or will prompt you for either a media cartridge in 
this job group that has expired (i.e., it is older than the time period you specified 
to keep it), or you will be prompted for a media cartridge from the Free Pool job 
group. You may also use a blank cartridge or any cartridge that is not in a 
Librarian-managed group.

As jobs are run against a linear job group, the media cartridges created are 
listed chronologically below the job group in the Librarian window with the old-
est media cartridge at the top of the list. When it is time to overwrite a media 
cartridge, ServerStor prompts you to insert the media cartridge at the top of the 
list (the oldest—and only if it has expired), and the recycling process begins.

� Tower of Hanoi.  The second media selection method is a backup strategy 
which uses the Tower of Hanoi media rotation. It's purpose is to allow the 
user with a very limited number of media cartridges to enjoy the benefits of 
data protection and archiving with a single backup strategy. Tower of 
Hanoi is explained in detail in the section “Tower of Hanoi” in Chapter 4, 
“Backup Operations.”
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The Media Group

The media group is the highest level of the hierarchy in the Librarian database. 
The media group contains one or more job groups which, as we have noted, 
contain one or more media cartridges with data sets (backups). 
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Creating Job Groups

As noted above, the basic structure of the Librarian database organizes back-
ups into a hierarchy with the media group at the highest level.

You'll recall that ServerStor refers to a single backup as a data set. The media 
where the backup is recorded is called the media cartridge. Media Cartridges 
with a common purpose are associated under job groups. Finally, job groups 
are grouped in the media group.

When you first install ServerStor, the Librarian database is created for you. The 
Librarian database includes the media group representing your hardware, and 
it includes three job groups: Free Pool, Restore Any Day and Archives.

If you have not already done so, you may wish to read the section “job groups” 
(earlier in this chapter) to review the two basic types of job groups (Free Pool 
and Librarian-managed) and the two media selection methods (Linear and 
Tower of Hanoi) available to you.

This section takes you step by step in creating a job group (in addition to the 
default Free Pool job group that is automatically created when you install Serv-
erStor.) To create a job group, perform the following steps:

1. Choose the Librarian button in the tool bar to open the Librarian win-
dow.

2. In the Librarian window, highlight the media group.

3. Select the Edit menu and choose “Create...”

4. The Job Group Properties dialog box for a Librarian-managed job 
group 
automatically appears, allowing you to set up specific attributes for the 
new job group.

The Job Group Properties dialog box consists of the following fields: 

� Name. Enter the name you wish to give to the job group.
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� Job Group Type.  Offers you the choice of a Linear job group type or a 
Tower of Hanoi job group type. If you select Linear job group, the Job 
Group Properties dialog box will display the Data Set Expiration field.

� Data Set Expiration.  This field is associated with Linear job groups 
only. Any media cartridge that you create with a backup job in a Linear 
job group will be kept for the period of time (days, weeks, months) that 
you specify in this field. If you specify “Never,” you will never overwrite 
a media cartridge in this group.

If you select Tower of Hanoi job group, the Job Group Properties dia-
log box will display the Media Cartridges field.

� Media Cartridges: This field is associated with Tower of Hanoi job 
groups only. Use this field to specify the number of cartridges for your 
Tower of Hanoi job group. (Refer to “Tower of Hanoi” in Chapter 4, 
“Backup Operations” for information regarding the number of car-
tridges used.)

� Last Write Date.  This field displays the last date information was added to 
the job group. (This field cannot be edited.)
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� Last Write Time.  This field displays the time of the Last Write Date. (This 
field cannot be edited.)

After making the appropriate entries in these fields, click one of two options:

� Add.  Saves the job group name and entries you make in the above fields.

� Cancel.  Closes the Job Group Properties dialog box. If you choose Can-
cel, none of the information entered in the above fields takes effect, and no 
new job group is created.
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Object Properties 

It's easy to get information about a file, directory, data set, media cartridge, job 
group, or the media group in your Librarian database. Highlight the object that 
you wish to know about from your File System or Librarian window, then select 
the Edit menu and Choose “Properties.” This section shows you the dialog 
boxes and fields for any object you select from your Librarian database.

File Properties Dialog Box

The File Properties dialog box gives you information about a file in the File Sys-
tem or Librarian. To access the File Properties dialog box, perform the follow-
ing steps:

1. Choose the File System or Librarian button in the tool bar to open the 
desired window.

2. Double-click the icon of the appropriate job group to display the media 
cartridges associated with the job group. Double-click the icon of the 
appropriate Media Cartridge to display the data sets on the cartridge.

3. Double-click the icon of the desired data set to display the directories 
in the data set. Single-click the icon of the needed directory to display 
the files in the directory. Then highlight the file you want information 
about.
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4. Select the Edit menu and choose “Properties” to display the File Prop-
erties dialog box.

The File Properties dialog box contains the following display fields (which can-
not be edited):

� Name. Displays the selected filename.

� Mac Name.  If a file was created with a Macintosh system and the name 
exceeds the DOS eight character limit, this field displays the Mac long 
name.

� Last Accessed Date.  In the File System, this field displays the date that 
the selected file was last accessed. In the Librarian, this field is not dis-
played.

� Size. Displays the size of the file in bytes.

� Last Modified Date.  Displays the date that the selected file was last modi-
fied.

� Last Modified Time.  Displays the time that the selected file was last modi-
fied.

� Attributes.  Displays whether the file attributes (Read Only, Archive, Sys-
tem, Hidden) are turned on or off.

� OK. This button closes the File Properties dialog box.
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Directory Properties Dialog Box

The Directory Properties dialog box gives you information about any directory 
in your File System or Librarian database. To access the Directory Properties 
dialog box, perform the following steps:

1. Choose File System or Librarian in the tool bar to open the desired 
window.

2. Double-click the icon of the appropriate job group to display the media 
cartridges associated with the job group. Double-click the icon of the 
appropriate media cartridge to display the data sets on the cartridge.

3. Double-click the icon of the desired data set to display the directories 
in the data set. Then highlight the directory you want information about.

4. Select the Edit menu and choose “Properties” to display the Directory 
Properties dialog box.

The Directory Properties dialog box contains the following display fields (which 
cannot be edited):

� DOS Name. Displays the volume letter and name of the selected directory. 

� Mac Long Name.  If a directory was created with a Macintosh system and 
the name exceeds the DOS eight character limit, this field displays the Mac 
long name.

� Creation Date.  Displays the date that the directory was created.
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� Creation Time.  Displays the time that the directory was created.

� Attributes.  Displays whether the file attributes (Hidden, System) are 
turned on or off.

� OK. This button closes the Directory Properties dialog box.

Data Set Properties Dialog Box

The Data Set Properties dialog box gives you information about any high-
lighted data set contained on a media cartridge. To access the Data Set Prop-
erties dialog box, perform the following steps:

1. Choose the Librarian button in the tool bar to open the Librarian win-
dow.

2. Double-click the icon of the appropriate job group to display the media 
cartridges associated with the job group. Double-click the icon of the 
appropriate Media Cartridge to display the data sets on the cartridge.

3. Highlight the data set that you want to access information about.

4. Select the Edit menu and choose “Properties” to display the Data Set 
Properties dialog box. 
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The Data Set Properties dialog box contains the following display fields (which 
cannot be edited):

� Name. Displays the name of the job, the data set number, the date of the 
backup, and the volume name of the selected data set.

� Last Accessed Date.  Displays the date that the selected data set was last 
accessed from the system.

� Creation Date.  Displays the date that the selected data set was created on 
the cartridge.

� Creation Time.  Displays the time of the Creation Date.

� Size. Displays the size (in bytes) of the data set.

� Attributes.  Displays whether the file attributes (Redirection Denied, 
Spanned) are turned on or off.

� OK. This button closes the Data Set Properties dialog box.

Media Cartridge Properties Dialog Box

The Media Cartridge Properties dialog box gives you information about any 
highlighted media cartridge within a job group and can be used to rename a 
media cartridge. To access this dialog box, perform the following steps:

1. Choose the Librarian button in the tool bar to open the Librarian win-
dow.

2. Double-click the icon of the appropriate job group to display the media 
cartridges associated with the job group.

3. Highlight the media cartridge you want information about.
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4. Select the Edit menu and choose “Properties” to display the Media 
Cartridge Properties dialog box.

The Media Cartridge Properties dialog box consists of the following fields:

� Name. Displays the name of the selected media cartridge. This name can 
be changed at any time. (If you do change the cartridge label, remember to 
change the external label on the outside of the cartridge, too.)

� Last Write Date.  Displays the date that the selected media cartridge was 
last written to.

� Last Write Time.  Displays the time of the Last Write Date.

� Last Accessed Date.  Displays the date that the selected media cartridge 
was last accessed from the system.

� OK. This button saves any changes made to the media cartridge name 
and closes the Media Cartridge Properties dialog box.

� Cancel.  Closes the Media Cartridge Properties dialog box. If you choose 
Cancel, any name change entered in the name field does not take effect 
and the media cartridge reverts back to its previous name.

Job Group Properties Dialog Box

The Job Group Properties dialog box gives you information about any high-
lighted job group in your Librarian. To access the job group Properties dialog 
box, perform the following steps:
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1. Choose the Librarian button in the tool bar. (You can also select the 
Window menu and then choose Librarian.)

2. Highlight the job group you want information about.

3. Select the Edit menu and choose “Properties” to display the Job Group 
Properties dialog box.

The Job Group Properties dialog box consists of the following fields: 

� Name. Displays the name of the selected job group.

� Job Group Type.  Displays the Media Selection type for the job group (Lin-
ear or Tower of Hanoi). 

If you created the job group as Linear, the Job Group Properties dialog box will 
display the Data Set Expiration field.

� Data Set Expiration. This field is associated with Linear job groups only. 
Any media cartridge that you create with a backup job in a Linear job group 
will be kept for the period of time (days, weeks, months) that you specify in 
this field. If you specify “Never,” you will never overwrite a media cartridge 
in this group.
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If you created the job group as Tower of Hanoi, the Job Group Properties dia-
log box will display the Media Cartridges field.

� Media Cartridges.  This field is associated with Tower of Hanoi job groups 
only. Use this field to specify the number of cartridges for your Tower of 
Hanoi job group. (Refer to the section “Tower of Hanoi" in Chapter 4, 
“Backup Operations.”)

" If the job group you've selected is the Free Pool job group, neither the 
Data Set Expiration nor the Media Cartridges Field will be displayed.

� Last Write Date.  Displays the last date that information was added to the 
job group.

� Last Write Time.  Displays the time of the Last Write Date.

After you have made the appropriate entries in these fields, click one of two 
options:

� OK. This button saves any entries you made in the above fields and closes 
the Job Group Properties dialog box.

� Cancel.  Closes the Job Group Properties dialog box. If you choose Can-
cel, none of the information entered in the above fields takes effect and the 
job group reverts back to the previous settings.
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Media Group Properties Dialog Box

The Media Group Properties dialog box gives you information about the media 
group in your Librarian. To access the Media Group Properties dialog box, per-
form the following steps:

1. Choose the Librarian button in the tool bar to open the Librarian win-
dow.

2. Highlight the media group.

3. Select the Edit menu and choose “Properties” to display the Media 
Group Properties dialog box.

The Media Group Properties dialog box consists of the following fields:

� Name. Displays the name of the media group.

� Location.  Displays the location of the backup device attached to your sys-
tem. 

� Drive Type.  Displays the backup device type selected for the media group.

� OK. This button closes the Media Group Properties dialog box.
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Viewing

The view of the Librarian database can be changed in two basic ways:

� Collapsing/Expanding the hierarchical view. 

� Altering the level of detail and sort order of displayed files.

The first approach uses the tree structure . The applicable commands are cho-
sen in the View menu:

� Tree Expand Branch.  Use this command to display the structures within 
the media group. When you select “Tree Expand Branch,” you will be 
prompted to enter 1, 2, 3, 4, or “All” levels.

� If you enter one level, you see the media group and the job groups 
within the media group.

� If you enter two, three, four, or “All” levels, the tree is displayed with 
varying amounts of detail. That is, you see different levels of job 
groups, media cartridges, and data sets.

� Tree Collapse Branch . This command has the opposite effect of the Tree 
Expand command: it collapses all expanded branches allowing you to view 
only the media group.

The second approach uses file details and the sort feature. You can select the 
level of detail to be shown and view the files in a variety of sorted ways. In the 
View menu, select Name Only, All Details, or Partial Details. If you select 
Name Only, you will see file names only with no details displayed. If you select 
All Details, you see the following information displayed: 

� Last Modified Date and Time

� Size

� Attributes

If you select Partial Details, a small menu is presented where you select any 
combination of the above three pieces of information.
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In addition to generating an unsorted listing of files (just select Unsorted in the 
View menu), there are several ways to produce a sorted listing of files. Select 
the appropriate command in the View menu:

� Sort by Name. Files are displayed sorted by name in alphabetical order.

� Sort by Extension. Files are displayed sorted by file extension in alphabeti-
cal order. 

� Sort by Size. Files are displayed sorted by file size in ascending order of 
size.

� Sort by Modified Date. Files are displayed sorted by the last modified date.

" Selecting a sort method does not in any way rearrange your Librarian data-
base. A sort method only gives you a temporary listing of selected directo-
ries and files in an order selected by you.
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Tagging Files in the Librarian Database

It is possible to tag files and directories in the Librarian database for restoring 
and verifying. To do so, step through the various levels of objects until you 
reach the desired directories and files:

1. Double-click the icon next to the desired job group. This will cause the 
media cartridges associated with that job group to be displayed.

2. Double-click the icon next to the appropriate media cartridge. This will 
cause the data sets on that media cartridge to be displayed.

3. Double-click the icon next to the data set you wish to view. This will 
cause the directories in that data set to be displayed.

4. Click or double-click the icon next to the directory you wish to view as 
explained below:

If you single click the icon next to the directory, all the files in that direc-
tory will be displayed. You can then individually tag all the files you 
wish to restore or verify. As you tag each file, a check-mark will appear 
just to the left of the filename. If you double-click the directory name, all 
the files in that directory will be displayed and automatically tagged for 
viewing. You will see check-marks next to all the filenames.

" You can use the mouse to tag and un-tag files. With the mouse, drag over 
a group of files to highlight them. Then hold down the shift key while dou-
ble-clicking the last file in the group. This tags (or un-tags) the whole group 
of files.

You can also use the “Tag/Un-tag” and “Tag/Un-tag All" functions to rapidly 
tag and un-tag files. Select the Edit menu and choose these commands 
when appropriate: “Tag/Un-tag All” will tag (or un-tag) all the files in a high-
lighted directory. “Tag/Un-tag” can then be used to un-tag a few files you 
don't want included in an operation.
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Locating a File

The Librarian database allows you to easily determine on which media car-
tridge a file is located. To access the Search Library dialog box, choose the 
Search button in the tool bar or select the Edit menu from the menu bar and 
choose “Search Library." 

The Search Library dialog box consists of the following fields:

� Search for.  Enter the name of the file you want to search for in this field. If 
you want to find out where certain files in a particular directory were 
backed up to, and you know the directory name, you can enter the file-
name and the path of that directory in this field.

You can also use “*.*” to search for all files backed up (from the selected 
volume) onto secondary media. The use of DOS wildcard characters is 
allowed. 

Example #1:  You want to find the locations of .DOC files in your library. 
Enter *.DOC in this field.

Example #2:  You want to find the locations of .BAT files in the \SYSTEM 
directory in your library. Enter SYSTEM\*.BAT  in this field.
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� From volume.  Access the pull down list in this field to select the name of 
the volume to be searched. This is the assigned name given when you 
installed ServerStor. If you do not specify a volume, the default value is all 
volumes.

� Include subdirectories.  This searches all subdirectories in the current 
path.

� File date restriction . 

� None.  Select this option to search for the specified file(s) without any 
regard to the file's last modified date and time.

� Most recent.  Select this option to search for the specified file(s) with 
the most recent modified date and time.

� Range.  Use this field to specify the last-modified date range of the 
file(s) to be searched.

After you have made the appropriate entries in these fields, select the Scan 
button. This will cause the Librarian to search for any instance of the particular 
file entered in the “Search for” field. 

� File System Path.  After executing a Scan, the scan list box displays the 
files found during the scan, the date and time the files were last modified, 
and the size of the files. If you highlight a file's name, the complete system 
path for the file will be displayed in the File system path field.

" There is a 100 file limit on matched files per volume.

After you have highlighted a file in the list box, select the View  button. This 
closes the Search Library dialog box and opens up the Librarian window which 
displays a highlighted directory location within the hierarchy, and also high-
lights the selected file (from the scan list dialog box) in the Librarian file view 
dialog box.

� Close.  The button causes ServerStor to stop searching for the file(s) and 
closes the Search Library dialog box.

" externally label all your backup media cartridges . If you don't label 
your media cartridges, restoring lost data will be much more difficult, 
recovering from a server crash may not be possible, and the major 
benefits of having ServerStor will be wasted.
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Speeding Up a Search

The more specific you make the entry in the “Search for” field, the faster the 
program can locate your file(s). For example: suppose you are looking for the 
file MAN.DOC, which resides in the librarian under 
\DOCS\JOHNB\ATE\MAN.DOC. If you type \*.DOC in the Search For field and 
select the Include Subdirectories checkbox, the program will search all subdi-
rectories below the root for the selected file. This may take some time.

The program will find your file faster if you furnishes the file information in the 
following form: \DOCS\JOHNB\*.DOC, and select the Include Subdirectories 
checkbox. The program will find your file even faster if he enters 
\DOCS\JOHNB\ATE\MAN.DOC. (Because you have entered a specific path 
and filename, you do not need to check the Include Subdirectories checkbox.) 
Page 39 ServerStor



The Librarian and File System
Moving a Media Cartridge 3
Moving a Media Cartridge

After you perform a backup, a media cartridge is created within the job group 
that you specified. ServerStor allows you to move the media cartridge to a dif-
ferent job group if you desire. To do so, perform the following steps:

1. Choose the Librarian button in the tool bar to open the Librarian win-
dow.

2. Double-click the icon of the appropriate job group to display the media 
cartridges associated with the job group.

3. Highlight the media cartridge that you want to move.

4. Select the Edit menu and choose “Move Media Cartridge” to display 
the Move Media Cartridge dialog box.

The Move Media Cartridge dialog box consists of the following fields:

� From . This field displays the name of the media group, job group, and 
media cartridge that you highlighted in the Librarian window.

� To. Enter the path of the media group and job group where you wish to 
move the media cartridge.

After you have made the appropriate entries in these fields, click one of two 
options:

� Move.  Use this command to move the cartridge (as designated in the 
“From” field) to a different location (as designated in the “To” field).
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� Cancel.  Closes the Move Media Cartridge dialog box. If you close the 
Move Media Cartridge dialog box without moving the media cartridge to a 
different location, none of the information you entered in any of the fields 
takes effect—and the Move is not executed.

" ServerStor offers an automatic way to move a media cartridge to the 
Free Pool job group. Just highlight the name of the media cartridge, 
select the Edit menu and choose “Move to Free Pool."

Deleting a Job Group or Media Cartridge

You can delete a media cartridge from a job group or a job group from the 
Media Group. To delete either of these objects, perform the following steps:

1. Choose the Librarian button in the tool bar to open the Librarian win-
dow.

2. In the Librarian window, highlight the media cartridge or job group you 
wish to delete.

3. Select the Edit menu and choose “Delete..." The Delete dialog box will 
appear.

The Delete dialog box consists of the following fields:

� Yes. Use this button to delete your job group or media cartridge.

� No. This button closes the Delete dialog box and cancels the Delete 
request.

" Deleting a job group also deletes from the Librarian ALL information 
pertaining to media cartridges and data sets that are associated with 
that job group. The data still exists on backup media, of course, but the 
Librarian will not be able to find it.
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Importing Media Cartridges

If you backed up data using another ServerStor installation, ServerStor allows 
you to add these media cartridges to your Librarian database. With the Import 
Media dialog box, you can read a backup media cartridge and put the informa-
tion from that cartridge into the Librarian database just as if the original backup 
operation had been performed under ServerStor. 

" To import  a media cartridge is to read a backup media cartridge and put 
the information from that cartridge into the Librarian database just as if the 
original backup operation had been performed under ServerStor. The infor-
mation imported will include the data sets on the cartridge; it becomes part 
of the Free Pool job group.

The Import Media dialog box is invoked by selecting the Actions menu in the 
Menu and choosing “Import Media.”

The Import Media dialog box consists of the following fields:

� To Media Group.  Displays the media group name. If the media group 
name is not already displayed, click the Librarian window and highlight the 
media group. Click again the Import dialog box. The media group name will 
then be displayed in the “To Media Group” field.

� Target.  Will open the Librarian window if it is not already opened.

After you make the appropriate entry in this field, you can click one of two 
options:
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� Import.  Performs the import action: the media cartridge and its data set(s) 
are automatically imported into the Free Pool job group. (You can later 
move the cartridge to another job group via the Move Media Cartridge dia-
log box.)

If the media cartridge already exists in the Library, you will be given the 
option of re-importing data on the cartridge over what is currently in the 
Library.

" If you choose to leave the media cartridge in the Free Pool job group, 
the cartridge will be eligible for overwriting.

� Cancel.  Closes the Import Media dialog box and cancels the request for 
importing a media cartridge.
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The File System and Tagging

The File System in ServerStor is most frequently used to tag files for backups. 
To tag any file in your file system, follow these steps:

1. Double-click the icon next to the desired directory. This will display the 
subdirectories.

2. You may now click or double click the name of the appropriate subdi-
rectory.

If you click the icon next to the subdirectory, all the files in that subdi-
rectory will be displayed. You can then individually tag all the files 
desired for a media operation. Check-marks appear just to the left of 
tagged files. 

If you double-click the subdirectory name, all the files in that subdirec-
tory will be displayed and automatically tagged for a media operation. 
You will see check-marks next to all the filenames.

" If you wish to automatically tag all the files in all  the subdirectories 
of a given directory, double-click the name of the directory. A 
check-mark will be displayed to the left of the directory.

You can also use the “Tag/Un-tag” and “Tag/Un-tag All" functions 
to rapidly tag and un-tag files. Select the Edit menu and choose 
these commands when appropriate: “Tag/Un-tag All” will tag (or 
un-tag) all the files in a highlighted directory. “Tag/Un-tag” can then 
be used to un-tag a few files you don't want included in an opera-
tion. You can also tag all files within a directory by selecting “Tag/
Un-tag All” from the Edit menu. Selecting “Tag/Un-tag All” again 
will un-tag all files.

The File System is also used for other purposes, and some of these purposes 
aid you in your backups as well. Some of the File System functions include:

� Viewing the File System

� Updating Last Accessed Dates

The File System commands are used to manage the File System and are exe-
cuted in the same manner as they are in managing the Librarian database. 
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The Include/Exclude Dialog Box

The Include/Exclude dialog box allows you to define exact path specifiers for 
including or excluding files from the Librarian and File System operations. It is 
accessed by selecting the Tools menu and choosing “Include/Exclude.”

The Include/Exclude dialog box consists of the following fields:

� Search.  Specifies the path of the files to be specifically included or 
excluded in an operation.

� Apply to Subdirectories.  Causes all subdirectories in the current path to 
be searched for any files matching the current specified field. If any files 
are found, they are designated for inclusion/exclusion.

� Files.  Enter the names of files you want to include or exclude in your oper-
ation. (DOS wildcard characters are allowed.)

After making the desired entries in these fields, click one of three options:

� Include.  This applies the selections to the files you have marked for inclu-
sion. 

� Exclude.  This applies the selections to the files you have marked for 
exclusion. 
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� Close.  Closes the Include/Exclude dialog box. If you close the dialog box 
without first applying your selections, the operation you execute does not 
include or exclude the files you selected.
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Choosing a Backup Strategy
With ServerStor you can perform two basic types of backups and apply restric-
tions to these backups. These backup types and restrictions are discussed 
below.

Types of Backups You Can Perform Using ServerStor

Backup Type Description

Complete Used to back up all directories and files. This is a 
file-by-file backup; it is not a disk image backup. In 
the event of a server crash, a Complete backup is 
essential for a recovery.

The Complete backup may require numerous 
media cartridges to backup an entire server.

Partial  Used to back up selected directories and files.

Restrictions on Backups

Restriction  Description Advantages Disadvantages

None  No restrictions 
are applied to 
the backup. 
(This is essen-
tial for disaster 
recovery!)

All directories 
and files 
selected will be 
backed up. 
Helps disaster 
recovery.

 May take 
longer. May 
require more 
media car-
tridges.
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Differential Used to back up 
all files that have 
changed since 
the last Com-
plete backup.

 Requires only a 
Complete 
restore and one 
Differential 
restore to 
restore a vol-
ume. Supported 
by the Rescue 
function. 

May use more 
media car-
tridges than an 
Incremental 
backup.

Incremental Also known as 
an Archive Bit 
set. Used for 
backing up all 
files that have 
changed since 
the last Com-
plete or Incre-
mental backup.

Uses fewer 
media car-
tridges.

Very limited 
backup. Makes 
recovery very 
difficult. Not sup-
ported by the 
Rescue function.

Date Range  Used to back up 
only those files 
within a desig-
nated date 
range.

Provides you 
with an extra 
copy of date-
sensitive data.

 Makes disaster 
recovery diffi-
cult. Not sup-
ported by the 
Rescue function.

Restrictions on Backups
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McAfee Rescue and Restore Any Day 

As explained elsewhere in this manual, users who perform a Differential 
backup daily and a Complete backup weekly can recover their protected vol-
umes from a catastrophic server crash by using the Rescue function. (Use the 
Protect button to add to the list of protected volumes.) Differential and Com-
plete backups also give you easy access to copies of frequently changing files, 
and enable you to restore your server to any day within a given time period.

When you install ServerStor, you get a feature called Restore Any Day (RAD). 
This feature provides you with a job group called MNS Restore Any Day. This 
job group contains two compound jobs which automatically perform the needed 
Complete and Differential backups. 

Restore Any Day is a linear job group that is created when ServerStor is 
installed. The two compound jobs (which are automatically scheduled) are:

� RAD_CMPL: This compound job contains jobs that perform Complete 
backups of volumes protected by ServerStor. 

Additional single jobs that perform complete backups of other volumes that 
you wish to protect can be added to the RAD_CMPL compound job. These 
jobs are created to perform appended backups in order to save media car-
tridge space. Use the Protect button to modify this compound job.

� RAD_DIFF: This compound job contains a single job that will perform a Dif-
ferential backup of your installation volume and ServerStor-protected vol-
umes. This job (INSTDIFF) effects an appended backup.

Additional single jobs that perform differential backups of other volumes 
that you wish to protect can be added to the RAD_DIFF compound job. 
These jobs should be created to perform appended backups in order to 
save media cartridge space.

" All jobs added to these compound jobs are automatically targeted to the 
Restore Any Day job group. 

By default, the RAD_CMPL job is set to run on a weekly basis, and the 
RAD_DIFF job is set to run on a daily basis. Also by default, all backups are 
saved for a period of one month. (You may shorten this period or increase it.) 
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Once the period for saving data has expired, the media cartridges become eli-
gible for overwriting. You will be prompted for the media cartridge with data 
sets whose age exceed the time limitation. You may, if you desire, put in 
another cartridge if it is available. 

" To perform the Rescue function, restore a file, or restore your server to a 
given day, refer to Chapter 5, “Restore Operations.”

Protecting Additional Volumes

When you install ServerStor, you are presented with the Rescue Setup menu 
which allows you to designate volumes to be listed. If, after your initial installa-
tion, you wish to update this list and add any unprotected volumes, choose 
“Protect” in the tool bar to display the Rescue Setup dialog box. For information 
on using this dialog box, see Chapter 2, “Data Protection Strategy.”

" To make a volume available to protect, make sure that you have logged on 
as SUPERVISOR or ADMIN.

Remember that the bindery and SYS volume are separate objects. You 
must back up the bindery in addition to backing up the SYS volume.

NetWare 3.x (and later) users should note that each server has its own 
bindery. Network 4.x users should also note that the NDS (NetWare Direc-
tory Services) volume, a global services database for all the servers on the 
network, must be backed up—in addition to  the other binderies and the 
SYS volume.
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Append and Overwrite

As you perform backups, you will perform either appended or overwrite back-
ups. Please keep in mind the following guidelines.

In Rescue-managed job groups , ServerStor tracks the media cartridges for 
you, prompting you for the proper media cartridge to use when performing a 
backup. You may decide to append to a media cartridge or overwrite it when 
the backup job is created. (This decision is made in the Backup Options dialog 
box; see “Backup Options Dialog Box” later in this chapter.) If you elect to 
append, ServerStor will prompt you for the media cartridge that was used for 
the last backup performed in this job group. If the media cartridge is full, you 
will be prompted for another cartridge. If you decide to overwrite, ServerStor 
will prompt you for either a media cartridge in this job group that has expired 
(i.e., it is older than the time period you specified to keep it), or you will be 
prompted for a media cartridge from the Free Pool job group. You may also 
use a blank cartridge or any cartridge that is not in a Rescue-managed group.

Any media cartridge in a Free Pool job group  is eligible to be overwritten. 
When you no longer need a media cartridge, you can move it to the Free Pool 
job group. Similarly, if there is a media cartridge in the Free Pool you wish to 
ensure is never overwritten, it may be moved to the Archives Group. If you 
elect to append when using the Tower of Hanoi rotation scheme, remember 
that the Tower of Hanoi does not support spanning.  The entire contents of 
an appended backup must fit on one media cartridge. If you perform multiple 
backups on the same day, the first backup should be an overwrite backup and 
the following backups should be appended backups.

" Externally label all your backup media cartridges. If you don't label your 
media cartridges, restoring lost data will be much more difficult, recovering 
from a server crash may not be possible, and the major benefits of having 
ServerStor will be wasted.
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Performing a Backup

" Target Service Agents (TSAs) are programs provided with NetWare that 
make proper communication on your file server possible. You must load 
the TSAs (and the RESQMAIN program) at the server, before perform-
ing any of ServerStor's operations (backups, restores, verifies).  See 
Chapter 2, “Data Protection Strategy.”

The File System Window 

To access the File System window, perform the following steps:

1. Choose the File System button in the tool bar to open the File System 
window. 

(You can also select the Window menu and then choose File System.) 
Either option presents you with the File System window.

2. Select the volume you want to use from the list of volumes located at 
the top of the File System window. Once you specify the source vol-
ume to ServerStor, you will see the directories, subdirectories, and 
files you may want to backup.

3. Tag the names of the desired directories, subdirectories, and files to 
back up. 

" For complete information on tagging files and directories in the File Sys-
tem, see the section “The File System and Tagging” in Chapter 3, “The 
Librarian and File System.”
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The Librarian Window

After you select the source volume and tag directories and files from the File 
System window, thus determining the source where files are backed up from, 
the next step is to determine the job group, or target, where files are backed up 
to. Selecting a job group is done within the Librarian window:

1. Choose the Librarian button in the tool bar to open the Librarian win-
dow. (You can also select the Window menu and then choose Librar-
ian.) Either option presents you with the Librarian window. 

2. Click the job group as the target where directories and files will be 
backed up. 

The Backup Dialog Box

1. Choose the tool bar's Backup button or select the Action menu and 
choose Backup. The Backup dialog box will appear.

The Backup dialog box consists of the following:
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� File System Drive.  This field displays the source volume (from a File Sys-
tem window) where files are backed up from.

� Source. Clicking this button will open the File System window if it is not 
already opened.

� To Library Job Group.  This field displays the target (from a Librarian win-
dow) Media and job group where files are backed up to.

� Target. Clicking this button will open the Librarian window if it is not 
already opened. 

� Run.  This performs the backup operation. While the job is running, the 
Backup status dialog box is displayed. (This dialog box is discussed later in 
the chapter.)

� Save. If you intend to perform a particular backup operation multiple times, 
you can facilitate the process by performing a Save. ServerStor saves the 
information you have entered in the various fields (including the names of 
all files you have tagged in the File System window).When you choose the 
Save option, the Save dialog box appears and you are prompted to give 
the job a name. Then, in the future, you can go directly into the Run Job 
dialog box, select the job you want, and the backup operation is automati-
cally executed.

" You do not have to execute a backup operation when saving it. You 
can access the Backup dialog box, enter the appropriate information in 
the dialog box fields, and click the “Save” command. The backup oper-
ation is ready to be executed when you need it.

� Options.  Displays the Backup Options dialog box (described below). 

� Preview.  Displays the Job Preview dialog box (described later in this chap-
ter).

� Cancel.  Closes the Backup dialog box. If you close the dialog box without 
choosing the Run command, no backup operation takes place. If you close 
the dialog box without exercising the Save option, no information entered 
in any field is saved.
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When the job is completed, the Backup Status dialog box is closed, the 
Librarian is updated, and the new data set is highlighted. If a problem 
occurs, a Job Error dialog box is also displayed. The Backup status dialog 
box is illustrated later in this chapter.

Backup Options Dialog Box

" Options selected now in the Backup Options dialog box are for the specific 
backup job you are currently setting up. Options selected here do not affect 
backup defaults. If you wish to select options that will be applied to all 
backups, you may do so by accessing the Backup Defaults dialog box by 
selecting the Options menu and choosing Backup Defaults.

The Backup Options dialog box is accessed by choosing Options in the Backup 
dialog box. Backup Options consists of these fields:

� Target Media.  This field offers you the choice of adding or overwriting data 
to a media cartridge.

� Append.  May cause data sets to be appended to the existing data on 
the media cartridge. (A new media cartridge might be chosen by the 
media selection algorithm.)
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� Overwrite.  May cause data sets to overwrite the existing data on the 
specified media cartridge. (Again, a new media cartridge might be cho-
sen by the media selection algorithm.)

" For guidelines on appending and overwriting media cartridges during 
backups, see “Append and Overwrite” earlier in this chapter.

� Backup restrictions.  Enter the type of backup you wish to perform. 

� None.  Use this type of backup to back up specifically tagged files with 
no restriction.

� Differential.  Use this type of backup to back up all files that have 
changed since the last Complete backup. A Differential backup does 
not reset the archive bit.

� Incremental.  Also known as a backup by Archive Bit. Use this type of 
backup to back up all files that have changed since the last Complete 
or Incremental backup.

� Date range.  Enter the date range of files you would like to include in 
your backup operation. 

� Apply Global Filters.  Applies the selections you have made in the 
Global Filters dialog box.

� Post Job Action .

� Update Library.  This field is selected as the default. If you deselect 
the Update Library box, your Librarian database will not be updated to 
show that these files were backed up. Backing up files without updat-
ing the Librarian is known as exporting data. This is done when you 
want to copy files for a reason other than backups (such as making a 
copy of a file for another user). For more information about the media 
group, see Chapter 3, “The Librarian and File System.”

� Verify.  Compares cartridge and disk data after the backup operation. 
This box is selected as the default.

� Clear Archive Bit.  The archive attribute is a bit that's associated with 
each file. ServerStor uses this attribute to keep track of files which 
have been backed up. 

After you have made the appropriate entries in these fields, click one of three 
choices:

� OK. Applies the selections you have made in the above fields.
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� Advanced.  Presents the Advanced Backup Options dialog box.

� Cancel.  Closes the Backup Options dialog box and resumes backup func-
tions. If you close without clicking OK, no information you entered will take 
effect.

Advanced Backup Options Dialog Box

The Advanced Backup Options dialog box is accessed by choosing Advanced 
in the Backup Options dialog box. Advanced Backup Options consists of the 
following:

� Prompt for : 

� Read-only files.  Prompts you when ServerStor encounters read-only 
files during a backup.

� Hidden files.  Prompts you when ServerStor encounters invisible, or 
hidden files during a backup.

� System files.  Prompts you when ServerStor encounters system files 
during a backup.

� Nonfatal error.  Backup operation continues through certain error con-
ditions (for example, open files) unless this box is checked. A list of 
files not backed up can be accessed by selecting the Tools menu and 
choosing “View Log.”
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� Deny Redirection.  Prevents files in a data set from being restored to other 
directories.

� Attempt to lock open files.  During a backup, some files may be opened 
by another application. If this check box is not selected, and ServerStor 
cannot have exclusive access to this file, it will attempt to record-lock the 
open file. Some applications will fail at this point. Selecting this box causes 
the open file to be skipped during backup operations and written to the 
Rescue system log.

� Hardware compression.  If your tape drive supports hardware compres-
sion, this option will cause the compression to take place.

" Hardware compression differs from data compression in that the 
former will compress data in the tape drive while the latter will com-
press data before it is sent to the tape drive. Hardware compression 
has the advantage of reducing demand on your machine, i.e., it is not 
employed in compressing data while a backup is taking place. (Hard-
ware compression is ON, by default, for backup devices that have the 
capability.

WARNING: If you have more than one backup device on a single con-
troller and data compression is activated by a jumper on that backup 
device type, you must either (a) jumper them all for data compression 
ON, or (b) jumper them all for data compression OFF.

� Automatic media naming.  Activates the Media Auto-naming function. 
This will cause any unidentified tapes to be automatically assigned a 
unique name/number identifier. (See “Auto-naming” later in this chapter.) 
By default, this feature is ON.

� Suppress Overwrite Prompt.  With this option ON, ServerStor will over-
write data on a media cartridge without notifying the user.

After making the appropriate entries in these fields, click one of two choices.

� OK. Applies the selections you have made in the above fields.

� Cancel.  Closes the Backup Advanced Options dialog box and returns you 
to the Backup Options dialog box. If you close the dialog box without first 
clicking the OK button, none of the information you entered in any of the 
fields will take effect.
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" Options selected in the Backup Options and Advanced Backup Options 
dialog boxes may be applied automatically to all backups via the Backup 
Defaults and Advanced Backup Defaults dialog boxes which are accessed 
by pulling down the Setup menu and selecting Backup Defaults. 

Global Filters Dialog Box

Use Global Filters to specify restrictions to a set of files that you have selected. 
These restrictions are in the form of an explicit list of files that are never to be 
backed up. Typically, the explicit exclusion list applies to all backups (and 
restores) you define and is used to exclude certain dynamic or system files.

To access the Global Filters dialog box, select the Tools menu on the Main 
Menu bar, and then choose Global Filters. 

The Global Filters dialog box consists of the following.

� Operation. Choose the operation for which the global filters will apply: 
Backup or Restore.

� File Exclusion list.  Displays the list of files that are never to be included in 
an operation. You may enter the name of a file in the box at the top of the 
list. (To exclude a given file in subdirectories, add “/S” after the file specifi-
cation.)

� Add.  Adds the file you have entered in the edit box at the top of the list.
Page 59 ServerStor



Backup Operations
Performing a Backup 4
� Delete.  Deletes any file highlighted in the File Exclusion list.

After you have taken the appropriate actions, you can click one of two choices:

� OK. Saves your file exclusion list for all future occurrences of an operation.

� Cancel.  Closes the Global Filters dialog box. If you close the dialog box 
without clicking OK, any changes you made to the File Exclusion list will 
not take effect.

Job Preview Dialog Box

The Job Preview dialog box is accessed by pressing the Preview button on the 
Backup dialog box. It consists of the following:

� Source.  Displays the type of backup you selected in the backup restric-
tions field in the Backup Options dialog box. Also displays the volume con-
taining the files selected for the backup.

� Target.  Displays the job group you have selected for your backup.

� Media Cartridge Selection.
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� Recommended.  Displays the recommended media cartridges you 
should use for this backup.

� Alternate.  Displays other media cartridges you can use for this 
backup.

� OK. This button closes the Job Preview dialog box and returns you to the 
Backup dialog box.

Backup Status Dialog Box

The Backup Status dialog box is displayed during a backup operation. It con-
tains the following fields: 

� Job.  Displays the name given to your backup job.

� Source.  Displays the source (from a File System window) where files are 
backed up from.

� Target.  Displays the target (from a Librarian window) media cartridge 
where files are backed up.
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� Directory.  Displays the directory that is currently being accessed.

� Files.  Displays the name of the file that is currently being backed up.

� Data Rate (MB/min).  Displays the speed (in megabytes per minute) at 
which the backup is taking place.

� Estimated.  This column displays the estimated number of files from 
the selected source, their total size (in kBytes) and time to back them 
up.

� Actual.  This column displays the actual number of files that are 
backed up, along with the actual total size and time it took to back 
them up.

� Verify files.  This field displays whether the verify option is activated.

� Hardware Data Compression.  By default, ServerStor turns this hardware 
feature on if possible, and lets you know whether it's on. 

" If the data of the first save set on a data cartridge is compressed using 
hardware data compression, all appended save sets on that cartridge, 
and all cartridges spanned to from that cartridge, will also be com-
pressed.

� Progress.  Displays what percentage of the backup job has been com-
pleted.

� Status.  Displays the current operation of the backup.

� Abort.  This button cancels the backup operation and closes the Backup 
Status dialog box.

� Iconize.  Minimizes the Backup Status Dialog Box. Progress (percent com-
pleted) is displayed on the icon, which appears on the desktop.

" If you have enabled the Rescue function—and we strongly recommend 
that you do so—then the Rescue disk will need to be updated when a 
Complete or Differential backup finishes. This is done automatically for 
you. If, however, you need to insert your Rescue disk into a floppy, you will 
be prompted for the Rescue disk when the backup job is completed.
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Spanning

ServerStor has a spanning feature that allows you to back up data sets that are 
too large to fit on one media cartridge. When your first cartridge becomes full, 
ServerStor checks for available cartridges in other backup devices on the 
server. If it cannot find another available cartridge, you are prompted to insert 
another cartridge and your backup spans to the next cartridge. This feature 
does not function with the Tower of Hanoi rotation scheme. 
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Auto-naming

If, during a backup, you use a media cartridge that has never been part of the 
Librarian (and is thus unidentified), ServerStor will automatically assign a 
unique name/number identifier to the cartridge.

" When you use auto-naming, remember that you'll need to externally label 
each media cartridge with its automatically assigned name.

The default name is MNS AUTO-NAME # , where “#” is replaced by the number 
assigned to the media cartridge by ServerStor. (Assigned numbers are 
sequential, beginning with 1.) You may change the default name by pulling 
down the Setup menu and selecting Media auto-naming. The Auto-naming 
Default dialog box will appear.

Each number is unique and will not be used again. Keep in mind, then, that if 
you have a media cartridge with a name/number that was assigned by Server-
Stor via the Auto-naming function, and you delete this media cartridge from the 
Library, the number will still not be used again for any new cartridges. 

" Remember that even with the auto-naming feature, you still need to exter-
nally mark the label information on the outside of the cartridge.
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Skipped Files

If for any reason ServerStor was unable to back up (and therefore skipped) a 
particular file, the file's name is listed in the Rescue System Log. This file can 
be viewed by selecting the Tools menu and choosing View Log.
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Passwords

Supervisor passwords are encrypted for each of the servers on your network 
and are stored in the Librarian. When you perform a backup for the first time 
after installing ServerStor, you will be prompted for the supervisor's password. 

" If the supervisor's password is changed, you will need to go into Server-
Stor's Security Maintenance and update it. Security Maintenance is 
accessed by pulling down the Tools menu and selecting Security Mainte-
nance. If you attempt to perform a saved job without having first updated 
the password in ServerStor's Security Maintenance, you will get a warning 
message to the effect that the supervisor's password for the server does 
not match the password in ServerStor's Librarian database.
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Run Job

If you save a backup as a job, you can run it later without having to re-enter the 
parameters and options. To access the Run Job dialog box, choose the Run 
Job button.

The Run Job dialog box consists of the following fields:

� Name box.  Displays the names of all the jobs you have saved and the two 
jobs that are part of the RAD feature. The jobs listed are either single or 
compound jobs, depending upon which option you select in the “Type” field 
as explained below. 

� Job Type.  Determines if the Name field will display single or compound 
jobs.

� Single.  A single job is one backup job that you have saved and 
named.

� Compound.  A compound job consists of a series of single jobs. Run-
ning a compound job will cause its single jobs to be executed sequen-
tially. (This is a good way to backup multiple volumes.)

After you have made the appropriate entries in these fields, click one of five 
choices.

� Run.  This button will cause the job highlighted in the name box to run.

� Preview.  This button will display the Job Preview dialog box (see the sec-
tion “Job Preview Dialog Box” found earlier in this chapter).
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� Edit.  This button will display the Edit Compound Job dialog box (described 
in the next section.) This option is not applicable to single jobs.

� Delete.  This button will delete the job highlighted in the Name field.

� Cancel.  This button closes the Run Job dialog box. No job will be run.

Edit Compound Job Dialog Box

The Edit Compound Job dialog box is accessed by selecting Compound as the 
Job type and then choosing the Edit button in the Run Job dialog box.

The Edit Compound Job dialog box consists of the following fields and com-
mands:

� Name. Displays the name of the job that will be edited in this dialog box.

� New. Clicking this button will display the Job Name box in which you 
can enter the name of a new compound job and a description of that 
job.

� Available Single Jobs.  Displays a list of all the single jobs that are avail-
able and can be added to the currently displayed compound job.

� Included Single Jobs.  Displays a list of all the single jobs that are 
included in the currently displayed compound job.
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� Add.  Clicking this button will add a highlighted single job to the cur-
rently displayed compound job.

You can also add an available job by simply double-clicking the job 
name.

� Remove.  Clicking this button will remove the single job highlighted in 
the Includes field.

" A compound job will cause its single jobs to be executed sequentially. This 
is a good way to backup multiple volumes.

When you add a single job to a compound job, you can place it in any 
desired location within the compound job so that it runs before another job. 
This is effected with the highlight bar in the Includes box. If a job in the 
Includes box is highlighted, a job added to the compound job will be placed 
to run before the highlighted job. If the highlight bar is below the list of jobs 
in the Include box, the added job will be placed at the end of the list. 

After you have made the appropriate edits, click one of two choices:

� OK. Applies the edits you have made.

� Cancel.  Closes the Edit Compound Job dialog box and returns you to the 
Jobs dialog box. If you close the Edit Compound Job dialog box without 
clicking the OK button, none of the edits you made will take effect.
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Tower of Hanoi Media Rotation

Few users need to keep a permanent record of all versions of any file, but 
many do need to have several recent versions of files easily accessible. The 
Tower of Hanoi Backup Group makes it possible to have many versions of a 
file on hand without having to keep a large number of cartridges on hand. 

The Tower of Hanoi is a backup method that uses several cartridges on a rota-
tional basis. The rotation of the media cartridges uses an algorithm that allows 
the user to backup several different versions of files with a minimum number of 
media cartridges. The algorithm causes the media cartridges to be rotated in 
such a way that most of your recent backups and fewer of the less recent back-
ups are saved. The date of the oldest version moves forward as your backups 
progress. The time interval between oldest and newest backups will always be 
the same.

" If you use the Tower of Hanoi media rotation scheme, structure your back-
ups so that the same data volumes are backed up on each media car-
tridge.

1024 Days

Each media cartridge in the rotation is accessed one-half as often as the pre-
ceding cartridge. With five cartridges being used for single daily backups, the 
date of the oldest version of a backup will be 8 days prior to the most recent. 
Eight cartridges being used for single daily backups increases the date horizon 
to at least 64 days and at most 127 days. Each additional media cartridge after 
eight causes the date horizon to increase dramatically. ServerStor supports up 
to 12 cartridges in a Tower of Hanoi rotation, giving you an effective date hori-
zon of 1024 days. The oldest file would be three years old. 

You can calculate the number of backups available for a given number of 
media cartridges by applying the following formula: 2n-2 = number of non-
appended backups where n is the number of media cartridges.

" Media cartridges may become worn out or ineffective due to their heavy 
usage. Replace frequently used cartridges on a regular basis. QIC car-
tridges are good for 2000 end-to-end passes. Helical-scan cartridges are 
good for 500 passes over any region of the tape. See the manufacturer's 
specifications.
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The table “Media Cartridge Rotation In Tower of Hanoi Backup” shows a repre-
sentative user's environment in which six media cartridges are employed in a 
Tower of Hanoi Backup Group. You can see that according to this table the first 
media cartridge is used for the 1st, 3rd, and 5th, backups, etc.; the second car-
tridge is used for the 2nd, 6th, and 10th backups, etc.; the third cartridge is 
used for the 4th, 12th, and 20th backups, etc.

" The Tower of Hanoi rotation scheme does not support spanning. The 
entire contents of an appended backup must fit on one media cartridge. If 
you perform multiple backups on the same day, we suggest that the first 
backup be an overwrite backup and the following backups be appended 
backups.

The Tower Of Hanoi media rotation scheme is named after the Tower of 
Hanoi game. The rotation of cartridges mimics the motion of blocks in the 
game.

Media Cartridge Rotation In Tower of Hanoi Backup

Media Cartridge Number Backup Occurrence

1 1, 3, 5, 7, 9, 11, 13, 15, 17, 19, 21, 23, 25, 27, 
29, 31

2 2, 6, 10, 14, 18, 22, 26, 30

3 4, 12, 20, 28

4  8, 24

5 16

6 32
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Backups As Part of Your Routine

To receive the most benefit from ServerStor, you should perform backups reg-
ularly. The frequency of your backups depends on how often your server is 
used. Generally, you should do a backup every day. That way you'll never lose 
more than a day's worth of data if your server fails. If data is critical and 
changes very quickly, you may want to back up more frequently.

Below are some guidelines for using ServerStor to protect your data.

1. Do a backup for each day your server is in use. For servers used daily, 
do a Complete backup weekly and at least a Differential backup on 
each of the other days. To ensure that you always do these backups, 
schedule them to run with the Job Scheduler dialog box (refer to 
Chapter 8, “Job Scheduler”).

2. Schedule backups at times when the server has little activity. If you 
find it difficult to schedule backups at such times, ServerStor informs 
you of any open files it skipped. 

3. Prolong the life of your data by storing media cartridges in their protec-
tive cases. Read the information that comes in the data cartridge pack-
age for tips on using cartridges. Store cartridges away from magnetic 
fields, including power supplies, cables, and computer monitors. Try to 
store the media cartridges in a vertical position.

4. For best results, we strongly recommend that tape drive users clean 
the magnetic heads on your tape drive on a regular basis. Consult the 
tape drive's installation and operations manual. 

" Externally label all your backup media cartridges. If you don't label your 
media cartridges, restoring lost data will be much more difficult, recovering 
from a server crash may not be possible, and the major benefits of having 
ServerStor will be wasted.
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If any of the following conditions occur, you may want to restore data.
� Data is deleted from your server.

� Data is corrupted on your server.

� You experience a hard disk failure.

� You want to revert to a previous version of the data.

� You replace your hard drive with a new hard drive.

This chapter contains basic information about data recovery operations. You 
should read this chapter and complete a few experimental restores to familiar-
ize yourself with ServerStor's restore operations.
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How To Recover From a Network Server Crash

McAfee Rescue

In the event of a catastrophic failure of any ServerStor-protected volume, you 
can automatically recover the data with your McAfee Rescue disk.

" To review the procedure for creating a Rescue disk, see the installation 
sections in Chapter 2, “Data Protection Strategy.” To ensure that all of your 
volumes are being protected by ServerStor, refer to the sections on the 
Rescue function and Restore Any Day, in Chapter 4, “Backup Operations.”

Each time you perform a Complete or Differential backup of an entire volume, 
and the backup is successful, the Rescue disk makes a notation of which car-
tridges have the last Complete backup and the last Differential backup. 

During a backup operation the Rescue disk records the results of the backup 
job, which consist of a data set's date and time and the media cartridges used, 
and creates a restore job file on the disk which includes this information. 

Overview

Recovering with the Rescue function is done in three stages:

� Reinstall NetWare if necessary.

� If the SYS volume crashed, install ServerStor on it. (See Chapter 2, “Data 
Protection Strategy” for details.)

� Use the Rescue function to recover all volumes. We recommend you 
recover the Binderies or NDS volume first; and then the Rescue volume. 
That way, you'll have the option of Completing the recovery process from a 
client station (under Windows), if you prefer.
Using ServerStor Page 74



Restore Operations
How To Recover From a Network Server Crash5
" NetWare 3.x users should note that each server has its own bindery.

NetWare 4.x users: Instead of a Bindery for each server on the network, 
your network has an NDS (NetWare Directory Services) volume, a global 
services database for all the servers on the network. So you need only 
recover the NDS (one volume) instead of a separate bindery for each 
server. 

If you decide to manually restore a set of binderies from an old backup, i.e., 
a backup with binderies different from your current binderies, you may gen-
erate errors in your network so that it does not operate properly: There will 
be a mismatch between objects that are called for now on the network and 
objects that existed at the time of the old backup. We recommend that you 
use the Rescue function and refrain from manually restoring the binderies 
or NDS.

Rescuing a Volume at the Server

If the disk volume where ServerStor and/or Windows was installed (typically 
SYS:) is the volume that crashed, you can restore that volume to its pre-crash 
state by performing the following steps:

1. Reinstall NetWare 3.x or 4.x on the SYS: volume, using a minimal 
setup and installation (See your NetWare documentation.)

2. Reinstall ServerStor.

3. Insert your Rescue disk into your floppy drive at the server where you 
installed ServerStor.

4. At the server console prompt, type :

LOAD <d>:RESQ ↵

Where <d> is the drive you used for your Rescue dis-
kette.

5. The RESQ program will begin by copying files to the server. Then, 
you'll see a list of protected volumes. (These are the volumes you des-
ignated during the original client-side installation routine, or which you 
added since then.)
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Type the number of the volume you want to recover. 
We recommend that you make the Rescue volume (by 
default, the SYS volume) the first one you recover. 
Then press the Enter key.

6. Now you'll see a list of the servers which currently exist on your net-
work. These are possible target servers for the volume you're recover-
ing. You can restore to the volume's pre-crash server by pressing the 
Enter key, or type the number of the server you want to redirect to. If 
the server list is too long to see on one screen and you want to view it 
again, press the Esc key.

7. You'll be prompted for your user name and password. Provide your 
user name for the server as you've re-installed it (typically, Supervisor 
or Admin). Then provide the associated password. 

8. Next, you'll see a list of volumes. You can restore the data from the vol-
ume you're recovering to any of these targets. As before, press Enter 
to restore to the pre-crash volume, or type the number of the volume to 
which you want to relocate.

9. The next prompt lets you know that ServerStor is about to restore a 
volume. Type “y ↵” to continue.

10. The Rescue function now loads RESQMAIN and begins the restore. 
You'll be prompted for each cartridge (by label) as required. Press 
Enter after mounting each cartridge.

11. When the volume is restored, you'll see a message on screen that 
summarizes the work done.

12. Repeat this process for each volume you want to Rescue.

Rescuing a Volume at the Client Station

" Important: Is your newly-created password the same as the one you were 
using before the server failed? If you've changed passwords, remember to 
update ServerStor, using the the Tools\Security Maintenance option, 
before trying to Rescue a volume or access the Librarian from ServerStor's 
Client-side interface.
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To restore other protected disk volumes (other than the disk volume where 
ServerStor and/or Windows is installed) to their pre-crash state, perform the 
following:

1. Choose the Rescue button from ServerStor's tool bar or select the 
Actions menu and choose Rescue a Volume. The Rescue a Volume 
dialog box appears:

2. Select the arrow in the “Volume” drop-down list box for a list of Server-
Stor protected volumes that can be recovered. Use the scroll bar to 
scroll through the list of protected volume names and select the vol-
ume name you wish to recover.

Restore the bindery first (or NetWare NDS if you are 
recovering a 4.x server.)

" NetWare 3.x (and later) users should note that each server has its 
own bindery.

" NetWare 4.x users should also note that the NDS (NetWare Direc-
tory Services) volume, a global services database for all the serv-
ers on the network, must be restored—in addition to  the other 
binderies and the SYS volume.

" If you decide to manually restore a set of binderies from an old 
backup, i.e., a backup with binderies different from your current 
binderies, you may generate errors in your Network so that it does 
not operate properly: There will be a mismatch between objects 
that are called for now on the network and objects that existed at 
the time of the old backup. We recommend that you use the Res-
cue function and refrain from manual restores of binderies.

3. After you select the volume to restore, press the Run button to begin 
the restoring process.
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4. As the restore process continues, Rescue will prompt you to insert the 
proper Complete and Differential media cartridges (if required) as 
needed.

McAfee's Restore Any Day Method (RAD)

If you've been performing Complete backups weekly and Differential backups 
daily to the Restore Any Day job group, then you can restore an entire volume 
or any file to the state it was in on a particular day. 

" We recommend that you do not  perform Incremental backups on any disk 
volume being protected by RAD. If you perform Incremental backups 
instead of (or in addition to) Differential backups, you may not be able to 
use the Rescue function to fully recover disk volumes. 

Follow the steps below to perform the Restore Any Day method.

1. Double-click the MNS Restore Any Day job group icon in the Librarian 
window 
to display a list of data sets within that job group.

2. Locate the Differential or Complete backup data set with the date you 
wish to 
restore the system to. (Hint: You can use the Search function to help 
identify the data set by locating specific file names, wild cards, and 
data ranges.)

If the date you wish to restore the system to is that 
of a Complete backup, then a full restore of the 
Differential backup is not needed.

3. If the data set you selected in step 2 is that of a Differential backup, 
you must first restore the last Complete backup prior to the date of the 
Differential. Otherwise, proceed to step 4.

4. After restoring the Complete backup data set, highlight the desired Dif-
ferential backup data set and perform a full restore.
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Performing a Restore 

With a little luck, you will never have to use the Rescue function to recover 
data. Instead, you'll be interested in performing regular, non-catastrophic 
restores. To do so, access the Restore dialog box: choose the Restore button 
from the tool bar or select the Actions menu and choose Restore. 

The Restore dialog box has the following fields:

� Source.  This text box displays the path, that you selected within the Librar-
ian window, where the files are to be restored from. Along with the name of 
the selected Data Set, this path includes the name of the media group, the 
job group, and the media cartridge.

" You can use the Search feature to locate a specific file or group of files 
you wish to restore. For more information about searching for specific 
files, refer to the section “Locating a File,” in Chapter 3, “The Librarian 
and File System.”

� Target.  This text box displays the path of the directory, that you select 
within the File System window, where the files are to be restored. If you 
wish to restore files to their original locations, be sure that this box contains 
only a volume name, colon, and backslash. (This specifies the root direc-
tory.) If you specify a target other than “root”, you will be performing a relo-
cated restore. For more details on relocated restoring, refer to the section 
“Relocated Restores” later in this chapter.

After making the appropriate entries in these fields, choose one of three 
choices:
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� Run.  Performs the restore operation. While the restore job is running, the 
Restore Status dialog box is displayed. (See the section “Restore Status 
Dialog Box” later in this chapter for more information about the status win-
dow.) If a problem occurs, a Job Error window is also shown.

� Options.  Select this button to open up the Restore Options dialog box. 
Within this dialog box, you can select a variety of optional prompting, 
exclusion filters, verify, and error handling options to the files that are about 
to be restored. (See the following section, “Restore Options Dialog Box.")

� Cancel.  Closes the Restore dialog box. If you close the dialog box without 
choosing the Run command, no restore operation takes place.

" If you perform a Complete backup weekly and a Differential backup daily, 
you are always ready to restore all of your data if necessary. With McAfee's 
Restore Any Day method, you can also restore your entire system or cer-
tain files to the state they were in on any particular day.

Restore Options Dialog Box

The Restore Options dialog box allows you to select a variety of options to files 
that are about to be restored. These options are applied only to the current 
restore operation about to be executed. If you wish to apply certain options to 
all restore operations, select the Setup menu and choose Restore Defaults. 
The Restore Options dialog box is accessed by choosing the Options button 
within the Restore dialog box.
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The Restore Options dialog box consists of the following fields:

� Prompting for.  (only if box is checked.)

� Read-only files.  Prompts you when ServerStor encounters read only 
files during a restore. This warning prompt allows you to either restore 
or not restore the file in question. If box is not checked, you are not 
prompted and files are restored.

� Hidden files.  Prompts you when ServerStor encounters invisible, or 
hidden files during a restore. This warning prompt allows you to either 
restore or not restore the file in question. If box is not checked, you are 
not prompted and files are restored.

� System files.  Prompts you when ServerStor encounters system files 
during a restore. This warning prompt allows you to either restore or 
not restore the file in question. If box is not checked, you are not 
prompted and files are restored.

� More/Less recent files.  Prompts you when ServerStor encounters 
files on your hard disk with the same name which have different dates 
or times than the files on the media cartridge. This warning prompt 
allows you to either restore or not restore the file in question. If box is 
not checked, you are not prompted and files are restored.

� Nonfatal errors.  Causes a warning prompt to be displayed for files 
with certain error conditions (for example, open files, disk write fail-
ures). If the box is not checked, you are not prompted and the file in 
question is skipped. An indication of why the file was skipped is written 
to the Rescue system log.

� Verify files.  Compares media cartridge and disk data after the restore 
operation. This box is automatically selected as the default. If the box is not 
checked, the verify pass does not take place after the restore operation.

� Apply Global Filters.  Select this box to apply the selections you make, in 
the Global Filters dialog box, to the restore operation. If the box is not 
checked, the selections you make in Global Filters are not applied. (See 
the section “Global Filters” immediately below.) This option does not 
affect restores of the Bindery or NDS volumes. 

After making the appropriate entries in these fields, choose one of two choices:

� OK. Saves the selections you made in the above fields, and puts you back 
in the Restore dialog box.
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� Cancel. Closes the Restore Options dialog box and cancels the modifica-
tions made within the Options dialog box.

Global Filters

The Global Filters dialog box is used to help you perform restore operations in 
much the same way it is used in backup operations. This dialog box offers a 
way to exclude certain files in a restore operation. To access Global Filters, 
choose the Tools menu and select Global Filters. The Global Filters dialog box 
then appears:

The Global Filters dialog box consists of the following fields:

� Options :

� Backup.  Select this option to exclude files from a Backup operation.

� Restore.  Select this option to exclude files from a Restore operation.

� File exclusion list.  Enter the names of the files you wish to explicitly 
exclude from your restore operation. The File exclusion list is applied only if 
the Apply Global Filters check box (located in the Restore Options dialog 
box) is checked.

� Add.  Adds a file to the exclusion list.

� Delete.  Deletes a file from the exclusion list.
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� OK. Makes changes you have input, and continues the operation.

� Cancel.  Continues without making any of the input changes.

Restore Status Dialog Box

After you initiate a restore job, the Restore Status dialog box appears.

The Restore status dialog box consists of the following fields:

� Job.  Displays the name of the restore job.

� Source.  Displays the name of the media cartridge from the Librarian win-
dow where the files are being restored from.

� Target.  Displays the volume letter and name where the files are being 
restored to.

� Directory.  Displays the directory that is currently being accessed for 
restore.
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� Files.  Displays the file name that is currently being restored.

� Estimated.  Displays the estimated number of files from the selected 
source, along with their total size (in kBytes) and the time it takes to 
restore them.

� Actual.  Displays the actual number of files that have been restored as 
the operation progresses, the actual total size, and the time required to 
restore.

� Data Rate.  Shows speed at which data is being restored, in MB per 
minute.

� Options :

� Verify files.  Displays whether the verify files option is activated or not.

� Hardware compression.  If your backup device supports hardware-
based data compression, this option controls it. Default is ON.

� Progress.  Displays how much of the restore job has been completed.

� Abort.  Cancels the restore operation and closes the Restore status dialog 
box.

� Iconize.  Minimizes the status dialog box and restore operation to an icon.
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Relocated Restores

ServerStor allows you to restore a single file, a group of files, or an entire direc-
tory from a Librarian data set, and transfer them to a different directory on your 
server. You select the redirection path by specifying the directory the file is 
contained in (the Librarian, or source) and the path where you want the file to 
be relocated to (the File System, or target). Follow the steps below to perform a 
relocated restore.

1. Open up the Librarian window and tag the desired files or directory 
within a single data set.

2. Open up the File System window and highlight the directory or subdi-
rectory where you wish to redirect the files you selected in the Librar-
ian.

3. Choose the Restore button from the tool bar. This action will open up 
the Restore dialog box.

4. In the Restore dialog box, you'll see two text boxes. The first text box is 
the Librarian data set, or source. The Librarian data set box contains 
the file or directory name and the path you tagged in the Librarian win-
dow. The second box is the File System path, or target. This box con-
tains the path you selected in the File System window.

5. At this time, you may wish to choose the Options button to set any 
prompting options for the files that are about to be restored. Choosing 
the Options button displays the Restore Options dialog box. (For more 
information about Restore options, see the section “Restore Options 
Dialog Box” earlier in this chapter.)

6. After completing steps 1-5, choose the Run button in the Restore dia-
log box to initiate the relocated restore. Choosing Cancel closes the 
Restore dialog box. If you choose Cancel, none of the entries in the 
Librarian and File System text boxes takes effect, and the relocated 
restore will not occur.
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Examples of Relocated Restore Operations

In the first example, the file LEON.TXT has been tagged from the Library data 
set. Therefore, the source path is SYS:\MUDDY\WATERS. To redirect the file 
to the subdirectory shown in the File System disk volume, the target path would 
be SYS:\HARVEST\MOON.

" Keep in mind that the source path ends at the lowest directory in the 
directory tree that contains all the files and subdirectories you have 
selected to restore.

In the bottom example, the user has selected everything below Dir 2 for 
restore. (That is, \DIR1\DIR2 is the source path.) This actually encompasses 
only two files. 

If these files are relocated to Dir 6, the result is as depicted in the bottom dia-
gram.
Using ServerStor Page 86



6Options and Utilities

Erasing a Media Cartridge
Erasing a media cartridge will remove all data sets contained on the cartridge. 
However, the blank cartridge remains in the Librarian and retains its name. It 
can then be moved to the Free Pool job group.

To erase all data from a media cartridge, perform the following steps:

1. Open up the Librarian window and highlight the media cartridge you 
want to erase. 

2. Select the Actions menu and choose Erase. The Erase dialog box 
appears.

The Erase dialog box consists of the following fields:

� Target.  This text box displays the name of the selected media cartridge 
you wish to erase, which includes the name of the Media and job group 
where the cartridge resides.

� Run.  Executes the erase operation for the selected cartridge.
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� Cancel.  Cancels the request for erasing a cartridge and closes the Erase 
dialog box.

If you decide you don't need to erase the data from the cartridge displayed in 
the Target text box, you can press the Target button and select another car-
tridge from the library, or simply cancel the operation.
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Retensioning a Media Cartridge

The retensioning feature is designed only for backup devices that support 
retensioning. Before you activate this option, make sure there's a media car-
tridge mounted. (If there isn't, you'll receive an error message.) 

From the Console . . .

Start ServerStor by typing

LOAD RESQMAIN ↵

The RESQMAIN screen shows a list of Input Commands. To access the 
Retension function, highlight it by moving with the up arrow and down arrow 
keys; or use the Tab key. Then press the Enter key. 

The retension operation begins immediately. An on-screen progress report 
generated by RESQMAIN indicates the cartridge is being retensioned. It also 
shows the currently active backup device's Device Number and SCSI ID num-
ber.

The progress report disappears when the operation is done.

From the Client Station . . .

To retension a media cartridge, perform the following steps:

1. Open up the Librarian window and highlight the media group or backup 
device where a cartridge is to be retensioned. 

2. Insert the desired media cartridge into the selected backup device.
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3. Select the Actions menu and choose Retension. The Retension dialog 
box appears.

The Retension dialog box consists of the following fields:

� Target.  This text box displays the name of the selected media group where 
a cartridge is to be retensioned. 

� Run.  Executes the retension operation for the media cartridge that is cur-
rently in the selected backup device. After choosing Run, the Retension 
Utility dialog box will appear. 

� Save. Pressing this button displays the Save Job dialog box where you 
can save the Retension operation as a separate job with a unique name. 
This allows you the ability to add this Retension job to a Compound Job 
later on. (Refer to Chapter 4, “Backup Operations” for more information 
about the Save Job dialog box.)

� Cancel.  Cancels the request for retensioning a media cartridge and closes 
the Retension dialog box.

The Retension Utility Dialog Box

After pressing the Run button to execute a Retension operation, you are pre-
sented with the Retension Utility dialog box, as shown below
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The Utility dialog box consists of the following fields:

� Job.  Displays the job name given to a saved retension job.

� Media.  Displays the physical location where a cartridge is being reten-
sioned.

� Status.  Displays messages about the retension job, such as initializing and 
tensioning. After the retension job has completed, you are presented with a 
small dialog box which displays the message “Retension Complete.”

� Abort.  If you chose to run a Retension job and then decide to cancel the 
operation, press the Abort button.

� Iconize.  Pressing this button minimizes the Utility dialog box to an icon.

" We recommend that you occasionally retension your media cartridges, to 
help ensure data reliability. 
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Backup Defaults

The Backup Defaults dialog box allows you to set up various backup operation 
defaults which will apply to all backup jobs, unless changed through Backup 
Defaults. These default settings can be changed for individual backup jobs by 
selecting the “Options” button in the Backup dialog box. Refer to the section 
“Backup Options” in Chapter 4, “Backup Operations” for more information 
about option settings for individual backup jobs.

To access the Backup Defaults dialog box, select the Setup menu from the 
menu bar and choose Backup Defaults. The Backup Defaults dialog box is dis-
played.

The Backup Defaults dialog box consists of the following fields:

� Post Job Action . 

� Update Library.  This check box is pre-selected as the default. If you 
deselect the Update Library box, your Librarian database will not be 
updated to show that these files were backed up. Backing up files with-
out updating the Librarian is known as exporting data. You deselect the 
Update Library option when you want to copy files for a reason other 
than backups (such as making a copy of a file for another user). Typi-
cally, data is exported to a “non-managed” media group only. (For 
more information about media groups, see Chapter 3, “The Librarian 
and File System.”)

� Verify.  Selecting this check box compares media cartridge and net-
work file data after the backup operation. This box is selected as the 
default.

� Clear archive bit.  The archive attribute is a bit that's associated with 
each file. ServerStor uses this attribute to keep track of files which 
have been modified since the last Complete or Incremental backup. If 
the Clear archive bit check box is selected the bit is cleared. If 
unchecked, the archive attribute is not cleared. This box is selected as 
the default.

" ServerStor uses date range to determine what has been backed up. 
Nevertheless, we enable archive bit control to allow compatibility with 
other backup programs, which may use archive bit.
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� Media auto-naming.  Generates a label for any media cartridge being 
overwritten, unless there is already a label and it appears in the current 
Librarian. Activate is turned on by default. If you turn the Activate option of 
and there is no name identified for the tape, you’re prompted to enter a 
name.

� Restrictions.  Enter the type of restriction you wish to apply to the backup 
job. The basic types of restrictions you can choose are explained below:

� None.  Select this option to back up specifically tagged files with no 
restrictions, or all files in the source volume if none are tagged. This 
box is selected as the default.

� Differential.  Select this option to back up all files that have changed 
since the last Complete backup.

� Incremental.  Select this option to back up all files that have changed 
since the last Complete or Incremental backup.

� Last Modified Date range.  Enter the date range of files you would like 
to restrict the backup operation to.

� Apply Global Filters.  Applies the selections you made in the Global 
Filters dialog box. (Global Filters can be accessed by selecting Tools 
from the menu bar and choosing Global Filters.) This box is selected 
as the default.

After you have made the appropriate entries in these fields, choose one of 
three command buttons:

� OK. Applies the selections you have made in the above fields, and closes 
the Backup Defaults dialog box.

� Cancel.  Closes the Backup Defaults dialog box without saving any of the 
information you entered in any of the fields.

� Advanced.  The Advanced button presents you with the Advanced Backup 
Defaults dialog box, allowing you to set up a more elaborate series of 
backup operation defaults.

The Advanced Backup Defaults dialog box consists of the following fields:
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� Prompt for Nonfatal error.  Causes a warning prompt to be displayed for 
files with certain error conditions (for example, open files or network data 
read failures). If the box is not checked, you are not prompted and the file 
in question is skipped. An indication of why the file was skipped is written 
to the ServerStor system log.

� Attempt to lock open files.  On multi-user systems, some files may be 
opened by another application. If this check box is not selected, and Serv-
erStor cannot have exclusive access to this file, it will attempt to record-
lock the open file. Some applications will fail at this point. Selecting this box 
causes the open file to be skipped during backup operations and written to 
the ServerStor system log.

� Suppress Overwrite Prompting.  Prevents ServerStor from prompting 
you before it overwrites existing data on a media cartridge. Turn this option 
ON for unattended operations, to prevent operations from stopping.

� Hardware compression.  Applies only to backup devices that have a hard-
ware data compression feature. Default is ON. Turns on or off automati-
cally if appending to a cartridge, matching the first save set on the tape.

� OK. Applies the selections you have made in the above fields and closes 
the Advanced Backup Defaults dialog box.

� Cancel.  Closes the Advanced Backup Defaults dialog box without saving 
any of the information you entered in any of the fields.
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Restore Defaults

The Restore Defaults dialog box allows you to set up various restore operation 
defaults. To access the Restore Defaults dialog box, select the Setup menu 
and choose Restore Defaults. The Restore Defaults dialog box appears.

The Restore Defaults dialog box consists of the following fields:

� Prompt for:  (only if boxes are checked.)

� Read-only files.  Prompts you when ServerStor encounters read only 
files during a restore operation. This warning prompt allows you to 
either restore or not restore the file in question. If this box is not 
checked, you are not prompted and files are restored.

� Hidden files.  Prompts you when ServerStor encounters invisible or 
hidden files during a restore operation. This warning prompt allows you 
to either restore or not restore the file in question. If this box is not 
checked, you are not prompted and files are restored.

� System files.  Prompts you when ServerStor encounters system files 
during a restore operation. This warning prompt allows you to either 
restore or not restore the file in question. If this box is not checked, you 
are not prompted and files are restored.
Page 95 ServerStor



Options and Utilities
Backup Defaults 6
� More/Less Recent files.  Prompts you when ServerStor encounters 
files on the network with the same name which have different dates or 
times than the files on the media cartridge. This warning prompt allows 
you to either restore or not restore the file in question. If this box is not 
checked, you are not prompted and files are restored.

� Nonfatal errors.  Causes a warning prompt to be displayed for files 
with certain error conditions (for example, open files or network data 
read failures). If box is not checked, you are not prompted and the file 
in question is skipped. An indication of why the file was skipped is writ-
ten to the ServerStor system log.

� Verify files.  Compares media cartridge and network data after the restore 
operation. This check box is automatically selected as the default. If the 
box is not checked, the verify pass does not take place after the restore 
operation.

� Apply Global Filters.  Select this check box to apply the selections you 
made in Global Filters to the restore operation. If the box is not checked, 
the selections you made in Global Filters are not applied.

After you have made the appropriate entries in these fields, you can choose 
one of two choices:

� OK. Closes the Restore Defaults dialog box and saves the selections you 
made in the above fields for future restore operations.

� Cancel.  Closes the Restore Defaults dialog box without saving any of the 
information you entered in any of the fields.
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Considerations

" This chapter uses the same network terminology as Novell's NetWare doc-

umentation (for example, “supervisor” for the LAN administrator).
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General Guidelines

In backing up your LAN, it's important to be aware of some special consider-
ations that make networks inherently different from stand-alone systems. Pro-
tecting network data is especially challenging because of the way data is 
stored on the file server and because of the diverse types of data involved.

Follow these general guidelines to ensure successful backup of your network 
data:

� Be sure that you have installed the hardware and software correctly, with a 
backup device physically attached to the file server. (See Chapter 2, “Data 
Protection Strategy” for details.)

� You must be logged onto the network as Supervisor to set up scheduled 
jobs or run manual operations.

Once these requirements are met, you can back up data from and restore data 
to the file server.
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General NetWare Support

The following ServerStor features provide you with full support in a NetWare 
environment. (Refer to the README.TXT file for additional information about 
NetWare support.)

� Preservation of file's Last Accessed Date.

� Update of NetWare's last archived date for all files backed up. 

� Protection of NetWare file attributes, trustee lists, and user rights.

� Support of  all NetWare name spaces.
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Keeping Track of Skipped Files

When you back up data on your LAN, ServerStor skips files that it finds open or 
locked. Skipped files are listed in the View Log dialog box. To access the View 
Log dialog box, choose “Tools” from the tool bar, then select “View Log.” (The 
skiplist is part of ServerStor's Librarian, and is available to multiple users from 
installed client stations.)

" The network supervisor should examine the ServerStor system log after 
every backup operation has ended, to ensure that no important data has 
been skipped during the backup. (Exclusions will not show in the system 
log.)
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Recreating Your File Server

The techniques described in this section can be used to rebuild your file 
server's data after a hardware failure. You can use these same methods to cre-
ate a duplicate or backup server. 

If you've been making Complete or Differential backups, this may mean restor-
ing from two or more data sets. And the LAN administrator must also take the 
bindery or NDS information into account. (ServerStor facilitates this by backing 
up the bindery or NDS as a separate volume.)

There are two basic methods of recovering the file server: using the Rescue 
function, and manual recovery.

The Rescue Function for Network Volumes

The Rescue function is an automatic disaster recovery method, enabling you to 
restore your entire network volume to its pre-crash state. To properly restore 
an entire server, you must first restore the bindery or NDS, then SYS volume (if 
necessary), then any other volumes. This ensures that the bindery files are 
restored before any other data.

Manual Recovery Procedures

This section describes manual recovery procedures to follow if you decide not 
to use the Rescue function and disk. Each of these recovery procedures com-
plements a different backup strategy. (Refer to the section “Choosing A 
Backup Strategy” in Chapter 4, “Backup Operations.”)

� Restoring from a Complete backup.

� Restoring from a Differential backup.

� Restoring from a series of Incremental backups.

Each of these procedures aims to preserve file ownership, to ensure that the 
complete data set has been restored, and to ensure that the most recent ver-
sion of each file is copied to the new file server (where multiple versions exist 
on media). 
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" IMPORTANT: By choosing to recover your network manually, you are tak-
ing on a complex task, each part of which can be essential to the integrity 
of your network. We strongly recommend that you use the Protect, Res-
cue, and Restore Any Day functions — not manual recovery.

" NOTE: Use of these procedures may result in restoring data that had been 
deleted or groomed from the file server, and that is no longer needed. You 
may have to locate and remove some such data after recreating the file 
server. This is especially critical if disk space is at a premium (e.g., if “Disk 
Full” errors occur during recovery).

Restoring from a Complete Selective Backup

If your standard method of backup is to perform a Complete Selective backup 
of the file server, recreating the file server is a relatively simple matter. After 
you've reinstalled NetWare, just complete the steps below. (See picture on 
next page.)

1. Restore the bindery or NDS (from its most recent backup) to the new 
server's SYSTEM directory. 

2. Restore all files from the most recent Complete Selective backup.

Restoring from a Differential Backup

If you've chosen a “Differential Backup” option (refer to the section “Choosing a 
Backup Strategy” in Chapter 4, “Backup Operations”), you must locate your 
most recent Differential backup, and your most recent Complete backup.

After installing NetWare on the new server, complete these steps.

1. Restore the bindery or NDS.

2. Restore the most recent Complete backup. 

3. Restore the most recent Differential backup cartridge. In effect, you're 
overwriting every file that has changed since the time you performed a 
Complete backup from step 2 (above), only this time you're restoring 
the most up-to-date versions available on a cartridge.
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" If your most recent backups were a Complete and Differential backup, you 
can recreate your file server by using the Rescue function or the Rescue 
disk.

Restoring from a Series of Incremental Backups

If you've chosen the strategy of Incremental backups, you must locate several 
cartridges: your most recent bindery or NDS backup; your most recent Com-
plete backup cartridge; and every Incremental backup cartridge you've made 
since the time that the Complete Backup was performed.

After installing NetWare on the new server, complete these steps.

1. Restore the bindery or NDS.

2. Restore the most recent Complete backup cartridge.

3. Restore the earliest Incremental backup cartridge in the set (the one 
you made just after the Complete backup cartridge you used in step 2).
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4. When this restore is complete, insert the next Incremental cartridge, 
and restore it the same way. Restore each of the Incremental car-
tridges in this way, in the order in which they were created. In effect, 
you're overwriting every file that has changed since the time you per-
formed a Complete backup from step 2 (above), with increasingly more 
recent versions. When the last “Incremental” cartridge has been 
restored, you'll have added the most recent available updates.
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8Job Scheduler

Introduction
The ServerStor Job Scheduler works like an alarm clock. It is a Windows utility 
that enables you to run the backup jobs you create and save in ServerStor dur-
ing the hours when you are not at your workstation. It can also serve as an 
alarm clock to remind you of meetings and appointments. In this chapter, we 
discuss the options in the Job Scheduler dialog boxes then show you how they 
are used to schedule backups and to leave messages. We also discuss using 
the Restore Any Day (RAD) backup strategy that is available when you install 
ServerStor. RAD (see the section on the Restore Any Day Method in 
Chapter 5, “Restore Operations” for more information) includes predefined 
backup jobs in ServerStor and predefined alarm settings in Job Scheduler that 
start the backups automatically.

To activate Job Scheduler, open ServerStor and select Setup/Activate 
Scheduler .

" If a check mark appears beside the Activate Scheduler option, the Sched-
uler was automatically added to the LOAD line in WIN.INI during installa-
tion.
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Options

Schedule Jobs Dialog Box

Click the Schedule button in the ServerStor Tool Bar, and choose Tools/Set 
Schedule to open the Schedule Jobs dialog box. Notice the four headings—
Job, When, Message, and Events—and five buttons below the Events box—
New, Test, Add, Chg, and Del. These four headings and five buttons are used 
to create and alter job schedules in Job Scheduler.

Job

The jobs you create and save in ServerStor are made available to Job Sched-
uler, and can be found under the Job heading. By clicking on an Event, the jobs 
that are part of that event appear in the Job field. Then click the arrow in the 
Job files box to display all the job. Select the job you wish to schedule. (Click-
ing on a job has no effect on the Events field.)
Using ServerStor Page 106



Job Scheduler
Options8
When...

Under the When heading, you set the time, date and frequency for the sched-
ule. The square clock is a button that opens the When dialog box where the 
details are worked out. The time and date next to the clock button are static. 
They show the schedule's time and date as set in the When dialog box. When 
you open the Schedule Jobs dialog box, the time and date displayed will be the 
time and date of the opening.

Choose the clock button to open the When dialog box. Notice it has two head-
ings: Time and Date. Under these two headings, the time, date and frequency 
are established in the schedule.

Time

This is the timer for the Job Scheduler alarm clock. Under this heading, you set 
the time you want your job to start. Your computer's clock is the reference 
clock.
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� Time text box.  This is the alarm setting. The time shown is the same as 
that in the Schedule Jobs dialog box and may be the time the Schedule 
Jobs dialog box was opened or the starting time of a selected schedule in 
the Events box. To change the time, click either arrow at the right of the 
box. This will scroll the minutes. When zero minutes is reached, the hour 
will scroll. You may scroll the hour by selecting the hour box and then click-
ing either arrow. The minutes will not be affected. You may also change 
the time by clicking the mouse pointer in the hour box and typing the start-
ing time you want.

� A.M./P.M. These option buttons indicate the period of day you want the job 
to run. If you scroll the time past 12:00, the period will scroll, too. However, 
if you type the time, you must select the period. Be sure the period is cor-
rect for when you want to run the job.

� Now.  Choosing the Now button will update the Time text box.

Date

Under the Date heading, you design the interval your job is to run. Select one 
of the seven interval options listed. Selecting an option will highlight one or 
more of the options to its right. These options help define the date parameter.

� Once.  Lets you schedule an Event to run only one time.

� Every.  Lets you establish an interval in days (enter the number in the text 
box to the immediate right). The default for Every is 14 days. This means 
the Event will run every 14th day starting on the day listed in the calendar 
text box to the far right. The maximum interval you can enter is 255 days.

� Calendar text box.  This option is activated when you choose one of the 
top two options. It is the first day you want the job to run. You may change 
the date by placing the cursor in the month, day or year box and clicking 
either arrow. Scrolling the date will change the month; scrolling the month 
will change the year. You may also type the date. The day beneath the box 
will reflect the date change. 

� Today.  Choosing the Today button will update the calendar text box.

� Every day.  Runs the job everyday.

� Every weekday.  Runs the job everyday Monday through Friday.
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� Every weekend.  Runs the job every Saturday and Sunday.

� Recurs.  Allows you to choose the specific day in the specific week of the 
month. For example, you could run a Complete backup the Friday of every 
fourth week in every month. The first list box gives you the choice of the 
week of the month—1st, 2nd, 3rd, 4th, 5th, every, or last. The second list 
box gives you the choice of the days of the week.

� Day of the month.  This option allows you to select a specific date of the 
month to run your job.

� In month.  This option is activated when you select one of the lower five 
options to the left of the bracket. It is a list box that allows you to choose 
one of the twelve months or every month to run your job.

� OK. Choose the OK command button to save the choices you've made 
and returns you to the Schedule Jobs dialog box. Your choices will appear 
under the When heading.

� Cancel.  Choosing the Cancel command button abandons the changes in 
the When dialog box and returns you to the Schedule Jobs dialog box. No 
changes are saved.

Message

Under the Message heading you select the visual and audible signals that tell 
you a job is starting or is about to start. Some messages include the option to 
continue or cancel the job. The options under this heading—Type, Text, Beep, 
and Tune — allow you to define the message that will appear. 

� Type.  This list box allows you to select the kind of Message you want: 
Announce, Confirm, 

� Countdown or Invisible.

� Announce.  A flag announcing the job is commencing. The announce 
message will remain on the screen until it is acknowledged but will not 
affect the job.

� Confirm.  A flag that gives you the option to continue or cancel a job. A 
Confirm will hold up the start of a job until you respond to the message.
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� Countdown.  Holds up the start of a job for a specific amount of time in 
case you wish to cancel. When the time runs out, it starts the job. The 
time limit is a default and can be set in the Options dialog box.

� Invisible.  Turns off the Message box. The job will run but there will be 
no visual prompt. The beep is not affected.

� Text.  In the Text box, you can write the message that will appear in the 
Message box when the alarm goes off. Just click the mouse pointer in the 
box and type.

� Beep.  The Beep is the audible part of the message that goes off when the 
clock strikes. If you do not want the beep, click the check box in front of the 
word Beep. The default for Beep is on and this will turn the beep off for just 
the job you are scheduling. You can change the Beep defaults in the 
Options dialog box.

� Tune.  This list box contains the tune titles you can select for the beep. If 
you have Windows 3.1 or better, your list will include .WAV file titles as 
well. You will need to install a sound playback card or Microsoft's 
SPEAKER.DRV file, a device driver for .WAV files. Microsoft's 
SPEAKER.DRV file is available on CompuServe or on the Microsoft BBS 
at (206) 637-9009. It is contained in a self-extracting archive called 
SPEAK.EXE.

The beep will repeat every 30 seconds until the Message is acknowledged 
or until the beep limit is reached. The limit is the total number of beeps 
allowed for each message and is set in the Options dialog box. You can 
stop the beeps before the limit is reached by pressing Esc.

� Musical note button. This button allows you to test a beep. Select a tune 
and click the musical note button and the tune will play.

Events

The Events box lists all of the jobs that have been scheduled in Job Scheduler. 
They are listed as summaries of the When dialog box. (See the illustration 
below.) The first job is to run at 5 p.m. every Monday. The second job is to start 
at 5 p.m. every Tuesday. When you select a job in the Events box, the job 
parameters will appear under the other headings in the dialog box. You can 
change the parameters.
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Job Scheduler keeps tabs on jobs that run. When a job finishes for the day an 
asterisk (*) will appear in front of its Event listing. A job that has completed the 
term set in its parameter will have two asterisks (**) in front of its Event listing.

Buttons

The five buttons below the Event box—New, Test, Add, Chg and Del— allow 
you to change, replicate, test, save your changes, and delete existing jobs in 
the Event box. The New, Test and Add buttons are always available and can 
be used at any time. The Chg and Del buttons are available only when a job in 
the Event box is selected.

� New. When you choose the New button, the When dialog box is open with 
the current date and time. Other schedule parameters are not affected.

� Test.  Allows you to test the schedule. It will display the Message, play the 
beep and run the job. If you have entered Job Scheduler from ServerStor, 
the Job Scheduler detects your interaction and displays an error message: 

Scheduled Jobs are waiting to run. . . .

This message refers to ServerStor. ServerStor must be closed for Job 
Scheduler to run a job.
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� Add. Replicates the selected job in the Event box. You can then tailor the 
highlighted job to suit other needs without sacrificing the original.

� Chg.  This button becomes active only after you have selected a job in the 
Event box. It allows you to hold the changes you make to a schedule with-
out leaving the Schedule Jobs dialog box. Chg does not save the changes 
you make permanently. Changes are saved when you choose the OK 
command button to exit the Schedule Jobs dialog box.

� Del. This button becomes active only when you select a job in the Event 
box. It allows you to delete the selected job. You may delete several events 
at once by:

� Holding down the Ctrl key as you click each additional job with the 
mouse.

� Holding down the Shift key and click the last job in the string of 
jobs you want to delete. This will capture all of the jobs in between.

� Clicking the mouse on the first job and dragging it down without 
releasing the button.
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Default Settings

Job Scheduler gives you the flexibility to tailor some of the options in the 
Schedule Job dialog box and some of Job Scheduler's working parameters. 
These parameters are characterized as defaults, and may be accessed by 
choosing Options in the Control menu. Choosing Options opens the Options 
dialog box.

Notice the headings Beeper and Message and the option button, Advanced. 
The defaults in this dialog box are concerned with elements in Beeper and 
Message. The Advanced option button opens the Advanced dialog box.

� Beeper.  The options under this heading are the defaults for the beeper.

� Enabled.  Allows you to turn off the beeper completely. When there is 
no X in this check box, the Job Scheduler beeper will not work.

� Beeper checked by default.  Activates the Beep check box in the 
Schedule Jobs dialog box. This turns the automatic enable on or off 
but leaves you the option to select either when you schedule a job. Job 
Scheduler is shipped with the beeper on.

� Default tune.  Allows you to choose the default tune for the tune list 
box in the Schedule Jobs dialog box. 

� Musical note button . Allows you to listen to the tune.
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� Stop after.  Allows you to determine how many times the beep will 
repeat. The beep is programmed to go off every 30 seconds until an 
operator responds to the message. A maximum of 999 beeps for 8 
hours 19<Insert equation here> minutes is available. 

� Message.  The options under this heading are defaults for Message in the 
Schedule Jobs dialog box. 

� Default message type.  Allows you to select the default message type 
for the Message type box.

� Countdown.  Allows you to establish the Countdown duration before 
the job is launched. The time box is divided into minutes and seconds. 
You can set it for 59 minutes and 59 seconds using the arrows. 

" Countdown cannot be tailored for specific schedules. When you 
establish the time, it becomes the default for all Countdown mes-
sages including those previously run under another setting.

� OK. Saves your changes and returns you to the Windows desktop.

� Cancel.  Abandons your changes and returns you to the Windows 
desktop.

Advanced...

Choosing the Advanced button opens the Advanced Options dialog box. 

� Confirm alarm deletes.  Allows you to turn off the delete's confirm mes-
sage that appears when you choose to delete a selected job in the Events 
box. 
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� Log to file.  Creates and keeps a log file of Job Scheduler events in the 
ServerStor directory under JSCHED.LOG.

� Confirm missed events.  If Job Scheduler is not open when a job is 
scheduled to run, that job will miss its appointment. By default, when the 
Job Scheduler is reopened, events missed since midnight will run. When 
“Confirm missed events” is turned on, the scheduler asks you for authori-
zation before starting the missed jobs.

� Client mode polls alarm file every.  This feature is disabled in this release 
of ServerStor.

� Hide Icon.  Makes the Scheduler icon disappear.

� Icon Titles . Warning: do not use these features; they will prevent your 
scheduled jobs from executing.
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Scheduling Jobs

Job Scheduler allows you to schedule the jobs you create and save in Server-
Stor to be run at your convenience. In this chapter we will discuss creating new 
schedules, altering existing ones, preparing your system to run the jobs, and 
the predefined alarms you can choose when you install ServerStor. 

In this section we will use simple scenarios to show you how to create a sched-
ule and how to alter an existing schedule. 

In preparing to schedule a job in Job Scheduler, you should be guided by the 
following questions:

1. What job do you want to run?

2. When and how often do you want to run this job?

3. What kind of flag should signal the job is starting?

These questions correspond to the first three headings in the Schedule Jobs 
dialog box: Jobs, When and Message. They are answered when you schedule 
a job. We will use the following scenarios to demonstrate how these questions 
are answered and jobs are scheduled.

Creating a Schedule

You have created and saved a Complete backup job in ServerStor. You want 
to back up everything on the network, every two weeks. Let's assume Server-
Stor is closed.

1. Double-click on the Job Scheduler icon at the bottom of the Windows 
desktop. This opens the Schedule Jobs dialog box. (Choosing the 
Schedule tool button in the ServerStor window will also open the 
Schedule Jobs dialog box.)

2. Click the Job files arrow under Jobs to open the Job files list box. 
Select the complete backup job you've created. 
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3. Choose the clock button under the When heading. This opens the 
When dialog box.

4. Change the time to read 11:30 p.m.

5. Since you want an interval of two weeks, select Every under the Date 
heading. The default is for 14 days, so you can leave it as it is.

6. Click the up arrow in the calendar text box until it reads the coming 
Saturday. This is the day your backup will start.

7. Choose OK to save your changes.

8. Click the Type options arrow to open the list box. Select Countdown.

9. Click the mouse pointer in the Text box. Type your message: 

This is the two week complete backup.

10. The Beep is enabled and Cuckoo is the default. Click the tune box 
arrow to open the list box. Select Bach.

11. Choose OK to save this schedule. A message box will appear:

Alarm date has changed. Save it?

Choose Yes. This saves the schedule and puts you 
back on the Windows desktop. Next time ServerStor 
runs, it will copy the scheduler's updated schedule 
file.

The default time for Countdown is 10 seconds. That means you will have 10 
seconds to decide if you want to cancel the job once the Message appears. 
You may want to change this.

1. Click the Job Scheduler icon. Choose Options in the Control menu.

2. Change Countdown to 1 minute.

3. Choose OK to save.
Page 117 ServerStor



Job Scheduler
Scheduling Jobs 8
Altering the Schedule

When you select an event in the Event box, all of its parameters are displayed 
under the other headings. You can alter an Event's parameters using the but-
tons below the Events box and by changing the individual parameters under 
each of the headings. We will use the following scenario to show you how.

Suppose you have a report that is due the 15th of every month. You have cre-
ated and saved a job file in ServerStor called Brutus, and now you want to 
schedule it to run when the report is done. You are already in the Events box, 
but have highlighted an already scheduled event.

1. Click the Add button below the Events box. This will replicate the high-
lighted event. You can make changes to one without altering the origi-
nal.

2. Choose the When button (the clock) to open the When dialog box. The 
parameters shown will be the same as the schedule you've just repli-
cated. They will need to be changed for the new job.

3. Change the time to 1:00 p.m. Doing this backup won't take long, and 
you will be available to insert the proper media cartridge.

4. Select the Day of the month option. Scroll the date box to 15.

5. Choose the OK command button.

6. Select Brutus from the Job files list box.

7. Select Confirm from the Type list box. 

8. In the Text box type: 

Special report backup. Load Brutus media cartridge.

9. Choose the Chg button below the Events box to hold these changes 
without exiting the Schedule Jobs dialog box. 

10. Choose OK to exit the dialog box. If you choose Cancel, Chg will be 
overridden and all your changes will be abandoned.
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Things to Remember when Using Job Scheduler

Job Scheduler makes your backup strategy more effective by running Server-
Stor jobs at times convenient for you. Since you are not going to be available, it 
is important that you prepare your system before you leave. The following is a 
list of things to do to ensure your jobs are run successfully.

" When Job Scheduler is running a job, your workstation will probably be 
unattended, so no one will see the prompts for inserting tapes and other 
requirements, and the jobs you schedule will still be waiting for you in the 
morning when you come in. 

1. At the server, make sure all device drivers,SMDR, and TSAs are 
loaded, and that RESQMAIN is loaded.

2. Make sure the correct media cartridge is in your backup device, and is 
labeled correctly for the backup job you are running. (If you are not 
sure which media cartridge to use for the job that is scheduled, you can 
find out by choosing the Preview button in the Run Job dialog box in 
the ServerStor window.)

" If you have more than one backup device on the server, make sure 
all the right tapes are in the right devices. 

3. Have your network's transport protocols loaded at the client station.

4. Access ServerStor in a way that preserves network security. That is, 
either

� Don't log in, but you must have either NETX for VLMs loaded. If at 
installation time you indicated you want the Scheduler to run auto-
matically, the Auto Login User can access ServerStor when the 
time comes. OR

� Log in as the Auto Login User (See the section called “Creating the 
Master Scheduler Workstation” in Chapter 2, “Data Protection 
Strategy”), OR
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� Log in as a user with restricted access, who can start ServerStor. 
The user must have access to SYS:\PUBLIC and the directory in 
which ServerStor is installed (making sure access to other areas is 
limited).

5. Make sure the Master Scheduler workstation is on, with Windows 
loaded and the scheduler on.

6. Make sure ServerStor is closed (Job Scheduler cannot run your job if 
ServerStor is open).

7. Make sure your server and backup device have beenpowered up.

8. Make sure the Rescue disk is in the appropriate diskette drive on the 
Master Scheduler workstation. (Note: this is essential for RAD jobs.)

9. If you are running more than one job, make sure they are part of the 
same job group and can use the same media cartridge. If a correct 
media cartridge is not recognized when the media is being validated, 
you will be prompted to change the media cartridge. The prompt will 
stay until you comply.

10. (Optional) Schedule a message for yourself to remind you of the job 
that will be running later.
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Pre-Scheduled Jobs: RAD

The default jobs are scheduled for 5 p.m. If 5 p.m. is inconvenient, you can 
change the time or other parameters when you select the job in the Events box.

To maintain the integrity of the RAD backup, we recommend that you first run 
the Complete backup manually. You can do this from Job Scheduler:

1. Load a new media cartridge into your backup device.

2. Close the ServerStor window.

3. Double-click the Job Scheduler icon on the Windows desktop.

4. Select Scheduled RAD Complete (the “Friday” job) in the Event box. 
(It's called RAD_CMPL.)

5. Choose the Test button under the Events box.

6. The Countdown message appears. You have 10 seconds to cancel the 
job before it starts. 

7. ServerStor is opened.

8. The backup status box appears and ServerStor builds the directory 
(see the status bar at the bottom of the text box).

9. Next, ServerStor will try to validate the media cartridge. If auto-naming 
(default) is turned off, the Enter Media Name dialog box will appear. 
Provide a name, and continue.

When the backup has completed, the Librarian will be updated and the pro-
gram will return to the Schedule Jobs dialog box. This media cartridge will be 
used for future jobs. 
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One restriction you may encounter is the expiration date for maintaining a data 
set. RAD is set up to maintain data sets for one month. During that time you 
may not overwrite the media cartridge data. RAD Complete backups are set up 
to overwrite data. You cannot reuse a media cartridge to do a Complete 
backup for one month. For the example above, this means that Friday, when 
the next Complete backup is scheduled, you must use a new media cartridge. 
(Refer to Chapter 4, “Backup Operations” for more information on overwriting 
and maintaining data sets.) 

Differential backups are set to append data and are not affected by this restric-
tion. We recommend you use a separate media cartridge for your weekly Com-
plete backup and daily Differential backups. If you have a lot of data, you may 
need to span a Differential backup during the week.
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Creating Your Own Tunes

You can write your own tunes for Job Scheduler. The ditties used in Job 
Scheduler are contained in the JSCHEDN.INI file in the Windows directory,  in 
a section called, appropriately enough, “Tunes.” The tunes are written so that 
the name of the tune is followed by an equal sign and a string of numbers sep-
arated by commas. For example:

Cuckoo=45/16,0/16,42/16

The numbers tell the computer what note to play and how long to hold it. Each 
number is pitch/duration and represents a single note. The pitch, or tone, is the 
top number and corresponds with the chromatic scale (see illustration). A 
pause is denoted by a pitch of zero.

The duration is the length of a note as expressed as a fraction of a whole note 
where 1 equals a whole note. The larger the number, the shorter the duration. 
Thus, 4 in this system would be <Insert equation here> of a whole note or a 
quarter note. Job Scheduler will always play the tune at 120 quarter notes per 
minute.

You can use up to 384 characters to define a tune.
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9Glossary

adapter
A hardware interface that allows communication between a host system (such 
as the server) and a peripheral device (such as the backup device).  Formerly 
known as the “controller;” sometimes called “adapter board.” 

Auto Login User

A “dummy” user I.D. created by the ServerStor installation program. The Auto 
Login user has a secure password and sufficient rights to operate ServerStor 
for scheduled, automatic operations.

backup device

Any hardware mechanism used for secondary storage (e.g., tape drive).

bindery

A database maintained by NetWare, to keep track of users, groups, work 
groups, and other entities. Under NetWare 3.x, a bindery exists for each 
server. (See also: NDS)

compound job

A job consisting of a series of named and saved Single jobs; running a Com-
pound Job causes its single jobs to be executed sequentially.

data set

A single backup recorded on a media cartridge.
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electronic label

Identification and descriptive information that ServerStor marks on the record-
ing medium. It's important to make sure that the media cartridge's external 
label matches the electronic label.

external label

The identification and descriptive information the user marks on the sticker 
affixed to the outside of a media cartridge. It's important to make sure that the 
media cartridge's external label matches the electronic label.

Free Pool job group

A pool of media cartridges that can be overwritten at any time; the Free Pool 
job group is automatically created in the media group.

job group 

A set of media cartridges that are associated because they share a common 
purpose. 

job group type

Method by which ServerStor manages the media cartridges in the job group; 
there are two job group types: Linear and Tower of Hanoi.

job log

A log file that contains messages about backup, restore, and verify jobs that 
were run. It resides on the server. 

label

See “electronic label”; see also, “external label.”
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linear

A job group type based upon a period of days that the user specifies to main-
tain data sets; once the period has elapsed for all data sets on a given media 
cartridge, the media cartridge can be overwritten.

media cartridge

An individually-mountable and uniquely machine-readable piece of 
media.(Typically a media cartridge is a tape cartridge.)

media group 

A set of job groups that are associated because they share a common type of 
media format. 

NDS

Under NetWare 4.x, a network-wide database for keeping track of users, 
groups, work groups, and other entities. (See also: Bindery)

Rescue disk

The diskette or local hard disk you specified (during ServerStor's client-side 
installation) as the source of volume recovery information. Default is a diskette 
in drive A:.

Rescue drive

See: Rescue volume

Rescue function

ServerStor's automated volume recovery process. Activated by the command 
“RESCUE” at the server, or by clicking the Client-side interface's Rescue but-
ton.
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Rescue volume (also, ServerStor volume)

The location you specified for the Rescue Disk. Default is A:.

single job

One backup job that has been saved and named.

SMDR

Storage Management Data Requester. Under NetWare, a program that passes 
information between a storage management program or utility (such as Server-
Stor or SBACKUP) and a TSA. (See: TSA)

Tower of Hanoi

A job group type based upon the number of media cartridges specified by the 
user; cartridges are used in a sequence such that the period between backups 
gets progressively greater with age.

transport protocol

Memory-resident programs that facilitate network communications. Under Net-
Ware 3.x, the transport protocols are IPX and NETX; under NetWare 4.x, the 
transport protocols are the VLM drivers.

TSA

Target Service Agent. Under NetWare, a memory-resident program (agent) 
that moves data between a specific server (target) and a storage management 
program or utility.
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AHelp

Getting Started with On-line Help
ServerStor's on-line Help facility is available whenever the Help command but-
ton is displayed on the screen. You can also request ServerStor's on-line Help 
feature by using one of the following methods:

� Press the F1 function key at any time to access the Help file.

� From ServerStor's menu bar, select the Help menu and choose Index to 
get a listing of ServerStor topics. Choose an item from the list to obtain the 
help information window about that item.

� To get help on any of ServerStor's dialog boxes that are actively displayed 
on your screen, press the Shift and F1 keys simultaneously, or just the F1 
key. This presents you with a window containing help information about the 
dialog box.

� To get help on an item in a menu, select the menu and highlight a particu-
lar item in that menu. Then press F1 to see a description of that item.

� To get help on a dialog box or the tool bar, place the mouse cursor any-
where on the dialog box or on any tool bar item and click the right mouse 
button.

Context Sensitive Help

The on-line Help facility is also context sensitive. This means that you can 
request Help or access specific information about any of ServerStor's features, 
tasks, and commands by pressing the Shift and F1 keys simultaneously. 
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How to Use the On-line Help Menu

In the following sections, we explain how to get on-line Help using your mouse 
or keyboard, brief descriptions of the Help menu items, and how to use Help to 
access information about ServerStor.

Using Your Mouse to Get Help from the Help Menu

1. Select the Help menu in ServerStor's main application window and 
choose Index.

2. Choose the item you want information about, then click that item.

Using Your Keyboard to Get Help from the Help Menu

1. Press the ALT key and the H key simultaneously.

2. Press the underlined letter for the menu item you want, or press the UP 
ARROW or DOWN ARROW key to highlight the item you want, and 
then press ENTER.

3. Select any of the command buttons in the Help window by simply 
pressing the underlined letter of that button.

If this is the first time you've used ServerStor's help facility, you might want to 
choose “How To Use Help” from the Help menu.

Using the Index Command to List Topics

1. From the Help menu, choose Index or press the F1 key. This will dis-
play ServerStor's main index Help window on your screen.

2. Highlight the topic you want information about.

3. Click the selected topic, or, press the TAB key until you reach the topic 
you want, then press ENTER.
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Using the Help Window Search Command

The Search command in the Help window is an easy and convenient way to 
find the specific information you need. When you want help on a certain topic, 
you can select or type the name of the topic in the Search dialog box.

Using the Help Window Search to Locate a Topic

1. From the Help menu, choose “Search for Help On” or press the F1 key 
to open Help, then choose the Search button. The Search dialog box 
will appear on your screen.

2. Select the word or phrase you want to search for. When you start typ-
ing, the list box automatically scrolls to those words that most closely 
match what you type.

3. Select the “Show Topics” text icon. This displays a list of topics at the 
bottom of the dialog box.

4. Select the topic you want to view, and then choose the “Go To” text 
icon. Information about the topic you select appears on your screen.

" You do not have to type an entire word in the Search For box. The Help 
feature matches the characters you type as closely as possible to the avail-
able keywords.

Getting Help for ServerStor's Dialog Boxes

We've made getting help for ServerStor's dialog boxes as easy as possible. 
Below is a list of steps to take to get help on any of ServerStor's dialog boxes.

To request Help on any dialog box:

1. While using a dialog box, press the Shift and F1 keys simultaneously, 
or simply press the F1 key. A window describing the contents of the 
dialog box appears on your screen.

2. Place the mouse cursor on the dialog box and click the right mouse 
button. A help window for the dialog box will appear.
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3. Press the Help button within a dialog box to display a help window for 
that box.
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BWhen Files Are Skipped

The ServerStor System Log File
Sometimes during a backup, restore or verify operation, ServerStor is unable 
to access a file. ServerStor may have skipped over the file during the operation 
for a variety of reasons. When ServerStor skips a file, the filename and a brief 
explanation of why the file was skipped are written to the System Log file. This 
can be viewed by selecting View Log from the Tools menu. (The default loca-
tion of the file is SYSTEM\MSN\FSPLN\SYSLOG.TXT.)

The explanations appear in a comment field that follows the filename. Server-
Stor always indicates the beginning of the comment field with a forward slash 
and asterisk (/*). Because file space is limited, the explanations are very brief.
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CError Codes

2000 There is no eligible media in any drives
You have an ineligible media cartridge in a drive, or a drive is not functioning 
properly. Make sure you are using the correct media cartridge. Use the Media 
ID function in the Main Console screen of ServerStor.

2001 Can't lock the device for the current operation

The device is currently being used by another application. Close the other 
application.

2100 No memory to complete request

You have insufficient memory to perform the operation. Unload some other 
application or install additional memory.

2101 Can't load media engine: ResqENG.NLM

The file ResqENG.NLM has been deleted, or, less likely, you have insufficient 
memory. Either unload some other application, or reinstall ServerStor.

2102 IT is NOT safe to unload ResqMAIN at this time

A clean unloading of files cannot take place. Activity is taking place that 
ServerStor cannot stop; unloading at this time may cause your server to abend.

2401 Devices of different type not supported

You are attempting to use incompatible devices, e.g., an FS1200 and an 
FS5000. See Chapter 1, “Introduction” for a complete list of supported devices.
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2403 Target SMDR not loaded

Target Service Agents (TSAs) are programs that load SMDRs and make 
proper communication possible on the file server. You must load the TSAs 
before performing any ServerStor operation. See Chapter 2, “Data Protection 
Strategy” for information on installing and loading TSAs.

The Target Service Agents (TSAs) must be loaded before performing any 
operation in ServerStor.

2404 SMS error — TSA not loaded

The Target Service Agents (TSAs) must be loaded before performing any 
operation in ServerStor.
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DSoftware Options

We've provided a set of powerful options for our most advanced users. With 

these tools, you can fine tune the way ServerStor uses memory, and thereby 
optimize the program's performance. 

To access these options from the console of a server on which ServerStor has 
already been installed, follow this procedure:

1. At the server console prompt, type:

load RESQINST

and press the Enter key. This activates the install 
program. 

2. You will now see the installation main menu. It features three options:

1) Advanced Software Options
2) Hardware Device and Adapter Options
3) Exit with Saving Software/Hardware Changes

Select option 1. 

Response : You will see the following setting: Maximum Transfer 
Buffer Pool Size (KB). This setting determines the size of the cache 
buffer. Increases can result in increased performance. The minimum 
value is 128KB. Increases should be made in 16KB increments.

3. When you're through changing the options in menu item 1, choose 
menu item 3 (Exit). You'll be prompted to confirm the changes. Choose 
Y to save the changes. Your selections are stored in the file 
RESQNLM.INI. 
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